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Sl Learning Guide Series

About This Quide

he Sl Learning Guide Series is designed to
teach Specsintact users the concepts involved
in successfully completing projects by fully uti-
lizing all the tools provided in the Specsintact system.
Each guide addresses a particular aspect of the sys-
tem, and clearly outlines the major points a reader
should understand at the completion of each chapter.

This QuickStart Guide provides a basic introduction
to many of the concepts that will be covered in more
depth in subsequent guides. It grew from a need to
help new users get a fundamental understanding of
Specsintact, but experienced users also find it helpful
as a refresher course. It's not intended to cover in-
depth every aspect of using Specsintact, but it is a
good place to begin. This guide does not cover the
installation process and assumes that you already
have both Specsintact and Master text loaded on
your computer system.

You are encouraged to use these guides in conjunc-
tion with the other user tools we provide, like the on-
screen Help, QuickTours and our web site re-
sources, which are all conveniently accessible from
the Specsintact Explorer's Help menu.

'Copyright NASA 2004
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e want learning Specsintact to A
be as painless as possible, so
we’ve designed these guides to
give you enough informa-

tion to get you going suc-
cessfully without over-
whelming you with every

possible detail. 'I Sally will help guide you through the process of

learning Specsintact. She’ll point out the pitfalls

Along the way, we'll point as she prepares you to process your project!

out key information that

you should remember, and

call your attention to things that you
should avoid. At the beginning of each
chapter, we’ll outline what you need to
learn from it, and at the end, we’ll summa-
rize the concepts you should have mas-
tered.

Throughout the guide, we’ll call your attention to important issues
using the symbols at the left. Below is a brief explanation of

‘\? — ﬁ“ what they mean:
! il -
l—n

) ..E. « Note — important point, so pay attention.

\
"’ f e Caution — the condition or action may cause problems —
proceed at your own risk.

‘ » Stop — means stop — don’t do it or you may regret it later!

2 Specsiiacr 8 ntroduction



At the beginning and end of each chapter,
Sally will outline the important points that
the chapter covers. Before moving on to

In this chapter you'll Iearn:
+ Point one.
Point two.

> &

the next chapter, be sure you have an
understanding of those points, since the
subsequent chapters will build on that
knowledge.

Point three.
Point four. @
Point five.

* o

* & & o o

Instructions that should be followed
in sequence are numbered.

1 Firstyou do this
2 Then you do this
3 Last, but not least, you do this

Text in bold indicates elements
you will find on your screen or
Specsintact terms:

File menu, OK button, Section

Actions appear in italics:
click, select

upport robLeMS NCOUNte['ed

Here’s where you'll find some real-life examples from our
Tech Support Desk. Learning from others’ mistakes is better than
making your own! The situations are real, the names are not.

What you learned from this chapter:
What you learned about point one.
What you learned about point two.
What you learned about point three.
What you learned about point four.
What you learned about point five.

Lists of important points are
bulleted.

Points to remember:
e Something

e Another thing

e Yet another thing

When you see the mouse symbol,
it means you can also right-click
to access the function.

roducion S
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What is Spccgfact?

an automated system with built-in quality checking
controls that lets you adapt standardized facility
construction specifications to fit your project.

S pecsintact is short for "Specification Kept Intact.” It's

Used worldwide by the National Aeronautics and Space
Administration (NASA), the U.S. Naval Facilities
Engineering Command (NAVFAC), and the U.S. Army
Corps of Engineers (USACE), Specsintact makes it
possible to assure quality control for project specifications
from beginning to end.

The Specsintact system --
designed by NASA and managed
at the Kennedy Space Center --

A Brief Sl History
1965 - Conceived by NASA

is used by
1986 - Adopted by NAVFAC engineers, :

architects How is Specsintact able
1988 - Adopted by USACE specification to check the accuracy of

the various elements within

writers, project Us el
the specifications?

managers and

construction managers doing business with _ _
It uses a special tagging sys-

the three supported government agencies.

Using Specsintact reduces the time and
expense required to produce facility
specifications, and helps eliminate costly
construction changes due to omissions,
discrepancies or improper quality controls.

So let’s get going with Specsintact!

tem similar to the one that tells
a web browser how to display a
web page. This tagging en-
ables the system’s reports and
other automated features, re-
ducing the time required to
complete your project. The
quality assurance reports verify
the accuracy of technical refer-
ences, submittals, and other re-
guirements. Now, you might be
thinking that this tagging
sounds mighty important —
well it is! That’s why in the sub-
sequent pages, you'll learn how
to get it right!

Infroduction
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In this chapter you'll learn:

¢+ What makes Specsintact unique.

Some of the common terms used.

What type of files can be used.

The main components of Specsintact.

The steps involved in producing a completed Job.

* & & o

ne of the first basics you should know about
If nO:hSOfTch-‘:ll r?p 0 Specsintact is that we refer to it as a system
cn whatr

rather than just software.

System yes, 1hereason we call it a system is that it's much more
word processor, no... than just a specification editing tool. It allows you com-
plete management of your projects — choosing the
specifications you need from standard guide specifica-
tions known as Masters, editing those specifications
to fit your project, utilizing automated processes and
quality control reports, and finally, producing your
completed specifications in a choice of three formats.

If you follow the editing
rules and use the quality
control and automated Learning the language...
features, you can produce
a final project that is com-
plete and accurate.

Chapter |




Specslintact Terms

t r If you're new to Specsintact, you may find some
MaS e S terms unfamiliar. Learning what they mean will help

\eS OUbp,., youunderstand how the system works and
Q,G\O(\e bm/f/

S how to communicate more effectively
{9 : )
regarding your project.

®.. Some terms you'll encounter are
‘ ®. unique to Specsintact, others are
Q @® industry-related and may already be
- g familiar to you, while still others are
(7] CCDD computer-related. Since Specsin-

c tact users come from a variety of
,% 0 backgrounds, we’ll define terms for
() @~ you as we go along.
% $
f 00 %’\} You'll also discover that some common
Reftrances

0(96, 9“ words have very specific meaning in
UOl]rBO\_}\.) Specsintact. For example, while working in

Lo a word processing document, you might say that
Workmg D|re [ you're having trouble with a section, referring to a

COW portion of the document. But when working in Spec-

sintact, a Section is actually an entire document. To

help you avoid confusion, we’ll point out Specsintact

terms by capitalizing them and displaying them in
bold when we discuss them.

Learning how to “speak Specslintact”
makes it easier for you to fully utilize
all its features and keep the Section
structure correct. You'll learn more
about Section structure in Chapter 3.

6 Spocsiniact Chapter



Specsintact Files

The type of files you edit in Specsintact
are called Sections — when you see
them on your computer system, they

e

- Masters contain 16 Divisions
that group the Sections based on
their content. You can identify
which Division a Section belongs to
by looking at the first two numbers
in the Section Name. For example,
Section 16064 Grounding comes
from Division 16 Electrical.

have a file extension of
.sec. Although they can be
created from scratch, most
of the time you'll be editing
Section files that you copy
from a Master.

Master Sections are for-
matted with the tagging

(there’s that word again!)

" A
JTWO menu items on

the Explorer’'s Setup
menu control which
projects display in the
left pane. Use the
Working Directories
command to choose
the Jobs you want
visible. Connect Mas-
ters lets you choose
which of the Masters
on your system will be
displayed. These two
commands can be
used at any time to
change the display.

Chapter |

necessary for Specsin-
tact’'s automated features
to work, but you must edit the content of
each to fit your particular project — usu-
ally referred to as a Job.

You'll see two main types of folders
displayed in the SI Explorer —
Jobs and Masters.

By clicking one of these folders in
the left pane, you can display all
the Section files it contains in the
right pane.

l&vailable Project=

-l NASA
-l UFGS

At the start, Section files are the

only type your new project
will contain, but as you
work, you will produce
other types, such as Re-
ports and output files. The

The only file type that is
ever edited in Specsintact
IS the Section (.sec) file.

Section (.sec) files are al-
ways the “editing” copy from which the
others are produced.




Specsintact Files

When you process and print a Job, you produce

files with the .prn file extension (you'll learn more
about processing in Chapter 5). These files are
displayed in the left pane of the SI Explorer in the
Processed Files subfolder under the Job. Just

like the Job folder, clicking a subfolder displays its
contents in the right pane. If you need to make
further edits, you must always edit the Section

(.sec) file, not the .prn file. When you process

your Sections again, the new Pro-

cessed Files will overwrite any previous [vaiabie Proiects
.prn or Report files.

You can also produce processed files [0 Processed Files
in two other popular formats: Microsoft < [ FOF Files
Word and Adobe PDF. Of course, ;
these require that you have the corre-
sponding software
on your system for
the output feature
to be available. These files
cannot be edited in Specsin-
tact — they are only for pro-
ducing a final copy of your
specifications in these for-
mats. The files they produce
are displayed in the SI Ex-
plorer, each type in its own
subfolder under the Job.

EI«IJ_'-| Masters
-l NASA
-l UFGS

: Once I've processed and
“ printed my Job creating
Word files, can | edit them in
Word?

Well, yes, but if you do, they
must be edited like any other
Word document without any of
the Specsintact quality controls,
and they cannot be returned to
Specsintact. If you ever have to
go back to that Job or Section in
Specsintact, any changes you
made through Word will be lost. So, what do you see when

It's best to make any changes in you open Specslintact?
Specsintact and then process

and print the Job again to pro-
duce new Word files.

5 Spocsiiact Chapter



Specslintact has ftwo main components: P —

the SI Explorer and the SI Editor. Bl Secions Process View Todks Selip ke
%g@:ﬂ i'|1]' ﬁ
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Through the Explorer, you accomplish o1 vt srans .
all the project management, like I - : —(
] | ikgE |28 Pt | haoy | naras g

putting together the specifications you
need, running the reports, and producing the final product. It provides a way to
visually manage the entire project — or multiple projects at the same time.

s’

Two common features you'll find in Specsintact are drag-and-drop and
right-clicking. For example:

In the Explorer, you can add Sections to your Job by dragging them from a
Master or from another Job.

e You can access many common commands by right-clicking and choosing

them from the pop-up menu.

i

As you read this guide, this symbol will identify functions that can be
alternatively accessed from a right-click menu.

SIEditor - [d:\sobs\myjobipulidatali 6064.5ec] HMEE

!JElir

Edi Wiew Insen Format Tools Window Hel 5 =l x|

FH & rE@ Hﬂﬂ%ﬂ.“b#ﬂ'ﬂﬂ. ME#‘#

h’*!"‘

<HICx<HTA NARE=FURFORHAT CONTENT=NEW:

L | TP AST i | Dt EDF D WL R B e T TR T @ B O v

-
BCNEEECTION 1406 BN j

<ATLOROUNDING |(CONNINICATIONS| EYETERE:SATL:
<BEEE S BT

S| Editor

IP<P|i‘T =1»<TTL»FART 1 SENERAL </ TTL»
<EFT =j.i24TTri.1 FEFERERCES<) TTL» . .
P _ You make changes to your specifications
“TAT>The publicasions lisced below fore a pars of Shis PEOLLDA %S0 GhE SNGEAS . . .y
BRARREADA </ TR in the Sl Editor. Although it's much more
_I_fIFIEF'- ok ARERICAN S2LCTETY FOR TESTIRG iND RATERIALE |AETH| /GRS —r'l than a WOFd processor’ It does have
4 * .
Py N A A mimsa= w= | many of the same standard features with

which you are probably already familiar.
But in addition, it has specialized toolbars and features to help you work more
quickly and accurately (especially using those all important tags we mentioned
earlier). The Editor is opened through the SI Explorer.

Chaprer B Specsinae o




Specsintact Work Flow

Start

Click the New
Job button on
:, _the toolbar.

Enter
the information in the
New Job dialog box.

Open the
S| Explorer

As with most computer programs, there
are multiple ways to perform many of the
common tasks. This illustration shows one
path, outlining the steps involved in using
the Specslintact system to help you assure
a quality end product.

Finish

e[t | o | | | st |
St [ rea—— f—
- e ™~

Al [ER—— o s |
T s [— fve——

—
e

= e
Use the Process and Print

function to produce your
finished Job.

= s Tl

Use the reports to locate and fix
errors in the Sections through
the Editor (run the reports again
until the corrections are made).

So, just what is the work flow for a
Job from beginning to end? Below
is a brief explanation of the basic
life cycle of a Specsintact Job.

== Select
Sections
you want

. , for your

== === ]Job using

the Add Sections dialog box.

- Use the Sl
Explorer to
" open each
- Section in
- the Editor.

Through =
the Editor, /=
make all
your =
changes
to the Sections.

mmmmmmm

Use the
Process
feature in
the Explorer
frequently

as you edit
to produce the quality
assurance reports.

Chapter |



Checlk-list

Before Starting a Job

Some very costly mistakes are rooted in a failure to communicate —
especially when starting a new project. If you'll be responsible for
starting a new Job and editing the specifications, you need to be able
the ask the right questions at the outset. This page contains a list of
suggestions and questions offered by
our Tech Support staff to get you
started on the right foot.

1 Download the latest Master text
to make certain you are using
the most recent specifications.

2 Print the Master Table of Con-

tents with Scope to give to your

engineer for the project. It can
be found in the SI Explorer with
the Master Sections, and is
named SCOPE.

The engineer should give you a

list of Sections to print so that

he can mark up the edits that
you will be making through

Specsintact. At this point, you

need to ask the engineer some

guestions before you begin.

« Will the units of measure for this project be
English or Metric? Should | print the Sec-
tions for mark up with both? (See the next
box if only one is required.)

o Will you want me to remove any Tailoring 3
Options that may exist? (These options
are tagged for easy removal when not
needed, and are usually specific to a re-
gion or particular agency—Ilearn more
about Tailoring in Chapter 3.)

« Do you require that the editing changes |
make be shown as Revisions? (When us-
ing Revisions, the changes are tagged as
added or deleted, but they are not perma-
nent until they are executed in the Sec-
tion.) This must be determined
before you beqin editing.

Now you can print the Sections. It's a good idea to print one at a time and print a Sub-
mittal Register with each for the engineer’s review.

1 Select the Section in the Sl Explorer’s right pane.
2 = Click the Print button on the toolbar and the Print Processing dialog box
will open. The recommended defaults are set for Masters, but if you need to

change the setting for Units of Measure, click the Options tab.

On the Reports tab, check Submittal Register.

You can change the printer destination at the bottom of the dialog box.

Click the Process & Print button at the top right of the box to send the selected

Section and its Submittal Register to the printer.

Chaprer T
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Upport

robLeMS

“I've been given a Section in PDF that I'm supposed to
add to the Job I'm working on. Can | edit this PDF file in
Specsintact?”

Sorry Betty, but once a Section is published in PDF (or Word)
you can't edit that output file in Specsintact. What you need
for your Job is the actual Section (.sec) file that was used to
produce the PDF.

NCOuUNtered

— Betty in Baltimore

5

L

What you learned from this chapter:

Specsintact’s not just word processing software, but rather a sys-
tem that enables both editing and processing of specifications, and
includes automated features and quality controls.

Specsintact consists of two main components: the Sl Explorer and
the Sl Editor. Through the Explorer, you accomplish all the project
management and processing, while the Editor allows you to edit
the content of the specifications.

The type of specification files that are edited are Section files with
a file extension of .sec.

Specsintact uses some specific terms that are important to learn
so that you can better understand how the software works, how to
maintain the proper structure for the Sections, and how to commu-
nicate with tech support and others regarding your work.

The basic steps involved in bringing a project to completion are:
creating the Job through the Sl Explorer, editing the Sections in the
Sl Editor, using QA Reports, and finally processing and printing the
Job through the SI Explorer.

The output format for the completed Job can be in the form of

the Processed files (.prn file extensions), Adobe PDF (.pdf), or {ﬁ:}\\%
Microsoft Word (.doc). These are output formats only and can- {i oo i
not be directly edited through Specsintact. PDF and Word re- W I
guire the corresponding software to produce. -

12 Spocsiiact Chapter



napter 2

In this chapter you'll learn:

+ How to start a new Job.

+ How to add Sections to your Job from different sources.
+ How to create a new Section using a template.

your first Job in Specsintact!

T he time has arrived for you to start

From the SI Explorer:

1 Click the green
folder on the tool-
bar, or click the File
menu, then New |
Job.

2 The Create New
Job dialog box will
open.

Chapter 2

Specsintact - MYJOB —

Tools  Setup Help

1 e A

File Sections FProcess Wiew

Mew Job
Create New Job Ed
General | Specitiers | Options | Comments |
A Jobr Mame: | e Csfle Cresbed: 110 2
me[ .
gontract [ Lot |
Speciter | E e
Pati [ stsgm =] Morking Dinscoies
- Mame: | HASA =1 | ™ Urified Submittsl Desetpton ! :>

Mastess

COUFGS © Amp 0 HASA N




[Required Fields

Rules & Restrictions

s J |
In addition to the

General screen, the
New Job dialog box
has three other tabbed
screens — Specifiers,
Options and Com-
ments.

The Options tab con-
tains the settings that
control Units of Mea-
sure and Revisions for
your entire Job. The
default for a new Job is
set for English mea-
surement with Revi-
sions off.

The Specifiers and
Comments screens do
not contain any re-
quired fields, but they
provide areas you can
use to track additional
information about your
Job.

All these screens can
be accessed at any
time by clicking the File
menu and choosing
Properties.

Job Name — identifies your Job in both the SI Explorer
and Windows Explorer, and is printed in the top right corner
of each page of your Job.

Rules: The Job Name can’t contain any symbols or
spaces, and it can’t be longer than eight characters. It auto-
matically appears in UPPER CASE letters. The name can
contain numbers.

Job Title — prints in the upper left corner of each page in
your Job. Although it is not visible in the SI Explorer, you
can display it by placing your mouse pointer over the Job
Name in the left pane.

Rules: The Job Title can’t contain more than 64 characters.
It can contain numbers, symbols, spaces, and both upper
and lower case letters.

Source — indicates the original source of the specifica-
tions used in your Job, which can be described in any for-
mat. Typical sources would be a CCB Disc # or web down-
load. This gives you a way to keep track of where your
Sections originated.

Rules: This information is only required if the correspond-
ing option is checked on the Setup menu | Options | Gen-
eral tab.

Primary Master — displays the Primary Master chosen
during installation. A different Primary can be chosen for
the Job from among your currently connected Masters,
which are listed in the pull-down. You can also connect ad-
ditional Masters, or change your default Primary Master, by
clicking the Connect Masters button just below the box.

Submittal Register Format — uses the Primary Master
you've selected to set the proper Submittal Register Format
for your Job. If you want to use an old Submittal Format for
one of the agencies, you must uncheck the box. If you want
to change these designations later, you can do so through
the File menu | Properties command.

Chapter 2



Adding Sections to Your Job

The Add Sections box is made
up of two panes.

Add Sections to Job: NEWJOB X|
—Contents of Jab: MEAJOBR

Action | section | Title

Add .. 01330 SUBMITTAL PROCED
Add .. 01420 SOURCES FOR REFE

S0 From...

%ﬁrsldnhsl Templatesl Browyse

Find more Masters. .. |

SOurce

MASA,
MASA,

Choose b azter(z] from st

| Titte
Master Last Updated April 01, 2003

Matmne
IMASL
UFGE

The right Contents pane
shows the Sections that you
have selected to be added.

The left Add From pane provides
four tabbed screens that you use to
choose Sections you want to add to
your Job from various sources.

|« | M« | D

< Back Divizions 3 0k

Select Al | Cancel | Help

Why do | see two Sections al-

- ready listed in the right pane
when when | haven’t added any to
my Job yet?

These two Sections — 01330 Sub-
mittal Procedures and 01420
Sources for Reference Publica-
tions — are automatically added to a
every new Job because they are nec-
essary for processing the Submittals
and References.

Chapter 2

...
If you don’t see the 01330 and
01420 Sections, then you probably
are not using a complete Master.
You must have these two Sections in
your Job, so hit the Cancel button.
Either download the full Master from
the web or access it from your CD.




Using the Add Sections Box

When either the Masters or Jobs tab is selected in the left
Add From pane, the buttons at the bottom will help you:

e Display Masters, Divisions and Sections

e Select the Sections you want to add to your Job

e Add the selected Sections to the right Contents pane

Add Sections to Job: NEWJOB X|

—&dd Fram... —Corterts of Jak: NEAICE
M&sters | Jobz I Templates I Browvse I Action | Source Zection | Title
Add .. MNASA 01330 SUBMITTAL PROCED
Choose Sections(s] from list Find mare hasters. .. | Add .. MASA 01420 SOURCES FOR REFE
Add .. MNASA 0333 LIGHTWEIGHT ARCHI
Project I Section I I Title Add .. MNASA 03475 PRECAST COMCRETE
Add .. MNASA 03601 CATALY FED METALI
NASA 11025 FIRE INSULATED:, REC s - " B —
MASA 11161 Dok LEVELERS ' ndo Add Section

MASA 11185 DoCH BUMPERS

Cancel

An asterisk next to a

Section indicates that it has { Right-click a Section and
already been added to the click Undo Add Section if
Contents pane at right. you want to remove it from

the Contents pane so that it
won't be added to the Job.

ol | AR INEY | il

* Section iz in Project

q winnsl SelectAl | Add Sections > < - ]> e

When you've finished
J selecting Sections,
As an alternative to using the buttons, you clicking the OK button
can double-click a Master, Job, or Division in will add them to your
the left Add From pane to display the contents. Job, close this box,
Double-clicking a Section adds it to the right and return you to the
Contents pane. Sl Explorer.

e Spocsiniect O Chapor 2



Adding Sections Using the Masters or Jobs Tabs

To choose Sections using either the Masters or
Jobs tab, in the left pane:

|/
You can select multiple

Sections by either holding
the Shift key (to select Sec-
tions listed consecutively) or
the Ctrl key (for multiple non-
consecutive Sections) as you
click your selections in the
Add Sections box. You can
also use the Select All button
to add every Section visible in
the left pane.

1 Click the Master or Job from which you want to
copy Sections, then click the Divisions button,
-- or double-click the Master or Job.

2 Click the Division from which you want to copy
Sections, then click the Sections button,
-- or double-click the Division.

3 To copy an individual Section, click the Section,
then click the Add Sections button,
-- or double-click the Section.

A Word About the Unified Facilities Guide Specifications (UFGS) Master

UFGS Sections can be used in either Army or Navy projects. Fully unified Sections have a
five digit Section name, while Army-specific Section names are followed with an A, and
Navy with N. These Sections are the only ones that contain a sixth digit in the Section
name.

NASA Sections still only contain five digits and are currently not part of the UFGS.

[ Templatesl Elrcnwsel

The other two tabs in the left Add From pane allow
you to either create a completely new Section from
a Template, or Browse to choose Sections from
your drives and network (.sec documents only).

Chaprer 2 B S 17



Using Templates

Creating New Sections and Local Masters

If you need to create a new Section, you can copy one of the Tem-
plates provided. These templates are formatted outlines to be used

as a guide so that the Section you create will have the proper structure.
Basic Templates distributed with Specsintact are:

|
These Templates
give you the proper struc-
ture, but while entering
your text, you must insert

— the proper tags (there’s
Template Description that word again!) in the

NASASECT NASA Unified Submittal Formatting

correct locations. You'll

learn more about tagging

UFGSMSTR Unified Facilities Guide Specifications Unified
Submittal Formatting for Masters

in Chapter 3. Be sure to

either overwrite or delete
the sample text that ex-

UFGSSECT Unified Facilities Guide Specifications Unified
Submittal Formatting for Sections

plains the content you

should enter, which acts

SUPP Used by software to create Supplemental Reference

File

as a place holder.

7
If you've had past versions of Specsintact loaded on your computer, older

versions of Section templates were not deleted from your system when you in-

stalled a newer version of Specsintact. In that case, you may also see the follow-

ing previous versions listed: ARMYOLD, ARMYSECT, NASAOLD, NAVYOLD,

and NAVYSECT. These can be removed by using the SI Explorer's Tools menu

| Section Templates dialog box. Select the ones you want to delete from the left

side of the box and then click the Delete button.

A good way to manage
any new Sections that
you need to create is to
maintain them in a Local
Master. This is a Master
that you create to hold
any Sections that you
may want to use again in
other Jobs. After you have
created your Local Master
and created and edited
your specialized Sections,
you can add them to any
Job in the same way that
you add Sections from
any other Master.

Creating a Local Master is similar to creating a Job.

1 Click the New Master button on the SI Explorer toolbar, |
or from the File menu, choose New | Master.

2 The Create New Master dialog box has two tabs to allow you to
define pertinent information about the Master that you are creat-
ing. It's advisable to name a Local Master something that is
easily recognizable to you, since it will be listed in the SI Ex-
plorer with your other Masters.

3 Click the OK button.

You can add Sections to Local Masters in the same way that you
add them to a Job, or create your own new Sections by clicking the
Templates tab.
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Adding Templates Using the Add Sections Box

= —&dd From...

W Maszters | Jobs —Templates | Elruwsel

: Y Enter Mew Section Murnber: @
e,

-
I“ Chooze Section T ermplate Maodity Templates... |
With the Templates tab selected: Name | Title I
Armyold EMTER ERIEF TITLE HERE
) Aamysect ENTER ERIEF TITLE HERE
1 Click the agency Template that you Masaold [ENTER APPROPRIATE TITLE ..
want to copy. Nasasect [ENTER APPROPRIATE TITLE ..
Navyold [ENTER APPROPRIATE TITLE ..
. . M avysect [ENTER APPROPRIATE TITLE ..
2 Enter a new Section Number in the OFGE5J0h0 JOBE SECTIOM TITLE >
IF a5 mstr [OFGSSECTION TTTLE - M.

text box (see Caution below about
assigning a correct number to a new
Section).

< | 2
< Back | Add Tiemplate |

3 Click the Add Template button.

@ When a new Section is created, it is important that your
engineer assign a correct number to it. The CSI Manual
of Practice should be used as a reference when determin-
ing an appropriate number.

You cannot duplicate an existing Section Title or Section
Number.

Revisions should not be enabled when using a Template
to create a new Section. Make sure they are off, not just
hidden on screen.

|
' Adding a Template to your Job in order to create a
new Section should not be confused with the Section
Templates command found on the Explorer’s Tools
menu. That function permits you to actually alter your
original Templates or create new ones.
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Adding Sections Using the Browse Tab

This tab allows you to search your system'’s drives and network for Sections
you want to add. They can be located anywhere, but they must be the .sec
file type and have the standard five or six character name. For example, you
cannot add a Word document (.doc) using this feature. You also could not
add a Section that had been renamed with an additional digit, like 04250A1.
No other file types will be visible using this Browse feature.

With the Browse tab selected:

1 Select the Drive you want to search from the pull-down list.

2 Inthe Directories box, locate the folder containing the file you want by
double-clicking the folders to display their contents.

3 Inthe Sections box, click the Section you want to copy.

4 Click the Add Sections button
-- or double-click the Section.

If you choose a Section that is already part of the Job, you will be asked if
you want to overwrite it. If you do, the Section that exists in your Job will be
replaced by the one you selected in the Browse process.

Upport robLeMS NCOUNtered

“I received a Section by email, and | saved it in a
temporary folder. How do | get this Section into the
Job I'm working on?”

— Polly in Peoria

The correct way to add a Section to your Job is through the
S| Explorer's Add Sections function. After you have saved a
Section on your system, use the Add Sections box’s
Browse tab to locate the Section and add it to your Job.
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Adding More Sections to Your Job

You can always return to the Add Sections
box at any time to add more Sections to your
Job.

'
Just click the button on the SI Explorer’s toolbar,
or from the File menu, click Add Sections.

v
J Another quick and easy way to add

more Sections to a Job is to use the drag
& drop feature in the Sl Explorer.

1 Inthe left pane, click the
Job you want to copy from
to display it's contents in
the right pane.

2 From the right pane, select
the Sections you want to
copy and drag them to the
Job folder you want to
copy to in the left pane.

Specsintact - LOCAL EEE3
E;Ia HSecioes l EfOTosS ViDL OO I SUDHElp ]

| 4| ) o

me | mlﬁ‘l.ml. Beeree LitaCad Maiben®
— P - I

Y OF WolRe
WELACE COMNCIETE (TH0NT I

What you learned from this chapter:

+ How to use the Create New Job box to enter the required
information to set up a new Job.

+ How to use the Add Sections box to choose Sections for your
Job from Masters or other Jobs.

+ How to add a Section Template in order to create a new Sec-
tion.

+ How to Browse your system drives and network to locate
other Section files you want to add to your Job.
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napter 3

Section Structure gﬁ'ags

In this chapter you'll learn:
¢ The correct format for a Section.
+ Proper tagging methods.

n order for Specsintact’'s automated '_
features to make your work easier 4 Some of the biggest
and your completed project accurate, and most time-costly
you need to understand and follow some mistakes made by new
important formatting guidelines. users of Specslintact
come from ignoring the
Each Section begins with a line that contains the Section structure and tagging
<SEC> tag followed by a meta <MTA> tag (this line is not requirements. If you learn
visible when tags are hidden, and it is not printed). It is fol- these, your editing tasks

lowed by the Section Number <SCN>, Section Title <STL> will be much easier!
and Date <DTE>, each on a separate line as illustrated be-
low. The teal triangle indicates a Note that is hidden. When
displayed, this Note at the beginning of the Section contains
a banner that defines the origin of that Section (more on
Notes in Chapter 4).
p <SEC:><MTL NAME=SUEFORMAT CONTENT=NEW:

<SCHN>SECTICON O5211</3CH>

] <3TL>STEEL JOISTS</STL>
Character Limits <DTE>09 99 fDTE>

Section Title
64 Characters

Following the Section header information,

Section Numb O
ection umber the body of the Section is broken down

5 Characters

(some UFGS use 6) into three Parts that conform to the
Construction Specifications Institute's
Date (CSI) standard three-part format.

5 Characters
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Parts & Subparts

Avrticles, Paragraphs and Subparagraphs

An exception: Division 00 and
Division 01 do not require the standard
three Parts , but if the Table of Contents
and Renumbering functions are to be
used, the Part and Subpart tags in Part 1
must be inserted.

Think of Section structure like a
numbered outline. Each Section has
three major top-levels called Parts.

Each Part contains a specific type of
information:

Part 1 covers specific administrative

and procedural requirements
<PRT =1>«<TTL>PALRT 1 GENERLL</ TTL> . .
—————————————————————————— unique to the Section. -—

. _ _ Part Titles are
Part 2 describes the quality of items  always in

<PRT =2»<TTL>PART 2  PRODUCTS</TTL» 'equired for the Job. UPPER CASE

Part 3 details preparatory actions
and explains how the products
outlined in Part 2 are to be used
in the Job.

<PRT =3><TTL=FART 73 EXECUTION</ TTL>

Each of a Section’s three Parts is further divided into three Subpart levels
(but no more than three!). The Subpart numbers are generated automatically
by Specsintact and placed inside the beginning Subpart tag. <SPT =1.1>

The first Subpart level under a Part is known as an Article. An
Article’s number is made up of the Part number (either 1, 2 or 3)
followed by a period and the Article number. In addition, the title
of an Article is always in UPPER CASE LETTERS, preceded by
the appropriate Subpart number, all of which must be sur-
rounded by Title tags <TTL>.

Here’s what an Article under Part 1 would look like:

<3PT =1.1%«<TTL>1.1 REFERENCESQ"TTL}?'
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Parts & Subparts

Avrticles, Paragraphs and Subparagraphs

I
The second and third level Subparts follow the same Character Limits
numbering outline — adding a period and number for Article

each level, with their titles surrounded by Title tags
<TTL> and preceded by the appropriate Subpart num-
ber — but they appear in Title Case Letters instead of

71 Characters

UDDEr case Paragraph

PP ' 68 Characters
A second level Subpart is called a Paragraph. An example of a Subparagraph
Paragraph under Part 2 would look like this: 60 Characters

<BPT =2.2 .48 TTL>2 .2 .4 Steesl Valwes in Plastic Lines</TTL>

A third level Subpart is called a Subparagraph. An example of a
Subparagraph under Part 3 would look like this:

<APT =3.2.4.1><TTL>3.2.4.1 Structural Projects</TTLx>

|
Do not attempt to add a forth level Subpart. If you need additional levels under a

Subparagraph, then use letters and numbers (surrounded by <ITM> tags) as follows:
1.1.1.1 Subparagraph
a. text
(1) text
These extra levels will not be renumbered by Specsintact the way Subpart levels are,
so if you make any changes, you must renumber them manually.

By now, you may be wondering about those funny looking little angle brackets < >
with the letters in between. User, meet the Tags! As we mentioned earlier, without
the tagging, Specsintact can’t do its job. Everything, E-V-E-R-Y-T-H-I-N-G
in Specsintact is tagged. The Editor gives you a special row of buttons for
inserting the tags — they are not typed manually. Without proper tagging,
the built-in quality assurance reports and Job processing cannot work

properly.

In the next few pages, we’ll give you some foundational information to help
you understand and use tags correctly. The illustration on the next page
shows the structure of a Part with tags and numbering.
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Secction Structure

Parts, Subparts and Tags

— KPRT =1>PART 1 FENERLL

— <3PT =1.1>1.1 [ARTICLE)

—=3PT =1.1.1>1.1.1

|: <3PT
</3PT =1.1.1.1>

<3PT
</SPT =1.1.1.3>

<3PT
<f5PT =1.1.1.4x>

L o /5PT =1.1.1>

L 2 /3PT =1.1>

=1.1.1.1>1.1.1.1

[:{SPT =1.1.1.2>1.
</SPT =1.1.1.2>
=1.1.1.3>1.

=1.1.1.4>1.

[Paragraph)

[Subparagraph)
(End of Subparagraph)

1.1.:2 [Subparagraph)

(End of Subparagraph)
1.1.3 [Subparagraph)

(End of Subparagraph)
1.1.4 [Subpacagraph)

(End of Subparagraph)

[End Paragraph)

[END OF ARTICLE 1.1)

— <3PT =1.2>1.2 [LARTICLE)
<3PT =1.1.2> [Paragraph)
[:{SPT =1.2.1.1=1.2.1.1 [Subparagraph)
<f/3FT =1.2.1.1> (End of Subparagraph)
<5PT =1.1.2> [End of Paragraph]
L </SPT = 1.2> [END OF AETICLE]
— </PRT =1> (LMD PLRT 1)

Notice that Parts have their own tag — <PRT> — but Articles, Paragraphs and

Subparagraphs all share the same Subpart tag — <SPT>. The way you can tell what
level a Subpart tag represents is by looking at the level number contained inside the tag,
such as <SPT =1.1.2>. This would represent Part 1, Article 1, Paragraph 2.
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Tags

The Keys to Specslintact

You can’t successfully use Specsintact without understand-
ing and using the tags correctly — so don’t even try! In the
long run, taking time now to learn about tagging will pay off
in the long run.

I
The tagging system used in Specsintact is similar to its g It iS possible to view a Section
better-known relative, HTML (Hypertext Markup Lan- on your screen without viewing
guage) that makes web pages display correctly in your  the tags, but when editing, you
web browser. In much the same way, Specsintact uses Should always have the tags visi-
tagging to distinguish between all the different elements ble to avoid big problems. We'll
in a Section. discuss this more in Chapter 5.

On the next page, we've listed some basic tagging rules
that you should keep in mind. But before we get into those,
below is the basic anatomy of a tag.

Most tags come in pairs — the beginning and ending tags
encompass the information that they define.
Notice that the end tag is distinguished by a backslash

/

within the tag.

8%

ot
A
s

¢ <TAG=Information to be tagged</TAG=>

|/
J While the tags most immediately surrounding information identify it, that information is
also contained within other higher level tags that have a relationship to it as well.

Think of it like a family tree: Mary is tagged as <wife> inside the <marriage > tags, but
she is also tagged with <mom> tags, too. Outside of the marriage tags, in her extended
family, she carries other tags like <daughter>, <sister>, <grand-daughter> and so on. So
it is with tagged elements in your specifications: a measurement, for instance, may also
be within tags for text, Subparagraph, Paragraph, Article, Part, and ultimately, Section.

With tagging relationships in focus, your editing will go more smoothly!
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Tags Rules

Some Basics

e ——
™ Tags are not typed, they
Every set of tags either com- are inserted using either
pletely encompasses another set, the corresponding button on
or the set is completely contained the tags bar of the Sl Editor,

within another set of tags. For or by using the Insert menu
example: and choosing the tag you

want from the drop-down
box. Inserting tags using
these methods insures that
<TST><TXT>text text text</TXT><TST> they are placed correctly and
that both beginning and end-
ing tags are used.

l lTXT tags inside

ST tags outside

OR

l lTST tags inside

<TXT><TST>text text text</TST></TXT>

TXT tags outside

BUT NOT

<Tff ><T£T>text text teXt</{ST ></lT XT>

TST and TXT tags are never interlinked

o All content in a Section must be tagged.

o Every Section must begin with a <SEC> tag and an end
with a </SEC> tag.

e The <SEC> tag is followed by a meta tag line:
<MTA NAME=SUBFORMAT CONTENT=NEW>

o All three Parts must begin with a <PRT =#> tag and an end
with a </PRT =#> tag.

o Every Article must begin with a <SPT =#.#> tag and end
with a </SPT =#.#> tag.

o Every Paragraph must begin with a <SPT =#.#.#> tag and
end with a </SPT =#.#.#> tag.

o Every Subparagraph must begin with a <SPT =#.#.#.#> tag
and end with a </SPT =#.#.#.#> tag.

o There must be three blank spaces between the number
that follows a <TTL> tag and the Title itself.
<TTL>2.2.4 Steel Valves</TTL>
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Tags Rules

More Basics

Typical Part, Subpart and Title tag lines look like this:

<PRT =1><TTL>PART 1 GENERAL</TTL> (===

Notice the three spaces that precede any title.

PART 1 GENERAL
1.1 REFERENCES

<SPT =1.1><TTL>1.1 REFERENCES</TTL> «

<SPT =1.1.1<TTL>1.1.1 Genera Requirements</TTL>

The end tag for an Article
appears when the number-
ing goes to the next Article
number in sequence. This is
also true for Paragraphs

</SPT =1.2></PRT =1><PRT =2><TTL>PART 2 PRODUCTS</TTL> g

<SPT =2.1><TTL>2.1 ALUMINUM ALLOY PRODUCTS</TTL>

<SPT =2.1.1><TTL>2.1.1 Aluminum Finishes</TTL>

<SPT =2.1.1.1><TTL>2.1.1.1 Anodic Coating</TTL>

</SPT = 1.1><SPT =1.2>

The end tag for a Part appears
just prior to the beginning tag
for the next Part, and on the
same line. Do not add extra
lines between them.

</PRT =1><PRT =2>

</SPT =2.1.1.1></SPT =2.1.1></SPT =2.1></PRT =2><PRT =3><TTL>PART 3 EXECUTION</TTL>«

All end tags for Articles,
Paragraphs, and Subpara-
graphs must appear on the
same line before the end tag
for the Part and the beginning
tag for the next Part.
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Tags

Definitions

Chapter 3

f N . The tags used in Specsintact are listed below in al-
fﬂj?b ‘.' phabetical order, followed by a brief description of
U= [y each. Some, including their content, are color coded
e on screen for easier recognition. These colors can
|“ be toggled on or off using the Editor’s View menu.

Additions (Revisions) - Green

Asterisk

Deletions (Revisions) - Red
Change Notice
Document File

Section Date

End of Section

English - Dark Blue

End of Document
Header

Underline

Italic

Bold

Center

Screen Highlight - Orange
Include

Item

List

Metric - Dark Red
Unified Submittal Format
Need Lines

Note Paragraph

Note

Organization Address

Organization

Other File

Page Break

Preparing Activity

Part

Reference

Reference Identifier - Pink
Reference Title
Submittal

Subscript

Section Number
Section Scope

Section

Superscript

Subpart

Section Reference - Violet
Section Title

Submittal Key - Blue
Tailoring Option - Teal
Table

Table Header

Table of Contents

Test Requirements
Title

Text

Hyperlink - Dark Yellow




Tags

Entity & Tailoring Tags

Just like every family has some unique individuals,
the Specsintact tagging family has some as well.

Tags that carry certain at-
tributes and perform func-
tions are known collectively
as Entity tags. Their func-
tions vary widely, and they
are included in the chart on
the previous page, but
here are a few examples:

When inserting a Note, instead of typing a
line of asterisks, you insert the <& AST> tag to
represent a line of asterisks. When you dis-
play the Notes and tags on your screen, you
will see the <&AST> tag instead of the aster-
isk line. When you display Notes without tags
visible, you will see the asterisk bars sur-
rounding the Note. So in this case, the tag
isn’t surrounding content, it is actually insert-
ing content — the line of asterisks.

Other Entity tags are:

« <MTA> designates that a Sections con-
tains the Unified Submittal Format.

e <&END> represents the —END OF SEC-
TION— line.

e <&EOD> used only for the Division 00
documents to represent End of Document.

e <&INC> is used only in Masters (primarily

Tailoring Options by Navy) to include their standard cover in

every Section.

Designated by the <TAI> tag,
Tailoring Options can be a bit
confusing, but they’re great time savers. They are used by the writ-
ers of the Master specifications to set aside information that you
can remove completely from the Sections if it doesn’t apply to the
project on which you are working. By placing it within <TAI> tags,
they’ve made it easy for you to remove this information without
manually editing it out of each Section in the entire Job. For this
reason, tailoring is often referred to as pre-editing. By using the
built-in features of Specsintact, it is possible to remove the contents
of <TAI> tags from individual Sections, or from an entire Job, with-
out ever opening the Sections in the Editor. You'll learn more about
using Tailoring in Chapter 4.
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Tags

Section 01420 Sources for
Reference Publications

References contains the following

tagged information for all the

References found in the

Master text:

o Reference <REF> tags sur-
round the information and other
tags for each reference publica-
tion listed.

e Organization <ORG> tags en-

Specsintact helps automate the

use of References in you Job. This great
time saver is controlled by the use of a
family of tags that identify the Reference-
related elements, a listing of References
within each Section, and a Section listing all
referenced publications. Your goal at the close the name of the sponsor-
end is to have these lists reflect only the ing org_anlz_atlon.

References actually used within your Job — e Organization Address <OAD>
a task Specslintact will accomplish for you tags surround the address,
during processing through Reconciliation phone, fax, email and Internet
— as long as the information is inserted and Informathn for each sponsoring
tagged properly. organization.

We’'ll cover more on adding
References in Chapter 4, and
describe how the Processing
function works in Chapter 5, but
for now, here are a few basics:

-
The content of the References cited in the Sections

is considered part of the specifications. Section 01420

supplies contractors with information they need to order

the necessary referenced publications.

In Chapter 2, we mentioned the

two Sections that are automatically added to
every Job because they are necessary for
processing your finished specifications. One (found in Part ) contains:

of them — Section 01420 Sources for . <REF> and <ORG> tagged information
Reference Publications — lists all the (but not <OAD>)

sponsoring organizations (with —
addresses) for publications that are
referenced in the Master text. During
processing, this list will be used to check
the Reference Publications.

The Reference Article of each Section

e Reference ldentifiers
<RID>

e Reference Titles
<RTL>

Within each Section, a listing of

References used in that Section is
contained in Part 1 within the Reference
Article (remember that an Article is a first
level Subpart). You can add to this list, but
you shouldn’t remove any References, since
any you don’t use in your final text will be
automatically excluded from the output files
you produce during processing.

Chaprer 3 T
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Tags

Section 01330 Submittal

Procedures contains the

following tagged informa-

tion:

« Submittal <SBM> tags

are found only in the
01330, and completely surround
the information and tags for each
Submittal Description and
Submittal Category.

e Submittal Descriptions (SD
Numbers) and Titles are sur-
round by <SUB> tags, which are
within a set of <TXT> tags.

e Submittal categories are sur-
rounded by List <LST> tags.

Submittals

Specsintact also automates the use
of Submittals in your Job, which
brings us to the second of the two
Sections necessary to process a finished Job:
the 01330 Submittal Procedures. This
Section lists all the Submittal Descriptions
— as well as pertinent instructions.
Submittals fall into one of eleven assigned
Submittal Descriptions (containing numbers
and names) that should not be altered.

Submittal Iltems are each listed under their
corresponding Submittals Description in the
Section’s Submittal Article (within Part I).
Only Submittal Items actually used elsewhere

N e S Gl SN OUId D el e ——
n thebSu.l()jmltt.al 'ﬁrt'ﬂe’ anddthey Submittals are items — such as samples or draw-
must Ie ! entlcgl ar;] tagge ings — that must be provided by the contractor. The
properly to enable the system to Submittal Register form can be generated from your

process the information correctly. Job to show all the Submittals in a grid format
The Submittal Article can be edited. 9 ’

In addition to the information contained in the
Job’s Sections, another document — called
the Submittal Register — can be produced The Submittal Article of each
when printing a Job if the Submittals have Section (found in Part |) contains
been correctly tagged. It lists the the following tagged information:
materials, products or items for e <LST>

each Submittal, and cites the e <SUB>

Section and Subpart location o <ITM>

where the Submittal is mentioned
in the Job’s text.

You will learn more about tagging

and formatting Submittals in Chapter 4, Outside

and in Chapter 6 we’ll cover more about  the Submittal Article, you

producing the Submittal Register. will only have <SUB>
tags.

™52 Spocsiisct Chapar 3



upport robLems NCOUNtered

“l'just finished editing six Sections of the first Job I've
ever done in Specsintact. Now my co-worker (who’s used
Specsintact in the past) says | should have been viewing what
she called “the tags” while | was editing. | got confused by all
those things mixed in with the text so | did my editing without
displaying them on the screen. Was this a mistake?”

Dottie in Dallas

Yes Dottie, that was a mistake. Without the tags visible, your cur-
sor may not be located where you think it is and you may be delet-
ing necessary information and tagging. It's vitally important that
your tagging is correct so that all the elements within your Sections
are identified properly. You will need to correct any tagging errors
in those six Sections, and from now on, always edit with the tags
visible on your screen.

What you learned from this chapter:

+ Sections have three top levels known as Parts.

+ Each Part can have no more than three lower levels known as
Subparts.

+ The three Subpart levels are called Articles, Paragraphs,
and Subparagraphs.

+ Parts and Subparts have specific numbering and title
requirements.

+ Allinformation in a Section must be tagged to be identified, and
Specsintact uses fifty different types of tags for this purpose.

+ Most tags come in pairs with both a beginning and ending tag
that encompass the information they identify. f

+ References and Submittals each use a family of tags to identify
their elements and assist in processing.

+ You should always display the tags on your screen when edit-
ing to avoid costly errors.
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In this chapter you'll learn:

Pre-editing using Tailoring Options.

How to open a Section in the Sl Editor.
Toggling on-screen elements using the toolbar.
Inserting tags using the tags bar.

To use Revisions while editing.

Shortcuts for removing tags and text.

How to remove or insert References.

How to remove or insert Submittals.

* & & 6 6 O o o

he time has finally arrived!

Armed with the knowledge

you've gained, you are now
ready to tackle editing your first Sec-

From the SI Explorer:

Specsiniact - MYJOB
Eile (Goctiors ) Process  Migw Tools Selup  Help

tion!

Taking the printed Sections that
have been marked-up by your engi-
neer, you can now use the Sl Editor
to make those changes to the Sec-
tion files in your Job. To do so, you
always start by opening the Job in
the Sl Explorer.

il |G

1 Click your Job folder in the left
pane to display the Sections it
contains in the right pane.

2 Use one of the following to open
the Section you want to edit in the
S| Editor:

— Click the Section once in the
right pane, then click

the Edit button on the ﬂ’|

toolbar,
OR

— Click the Section once in the

Ty e [ S— T — right pane, then click the Sections
1 AT i s e menu and choose Edit,
o s ea— i %_
B maeonaosisonms | ameedTe — Double-click the Section in the
B aiin LSRN STRUCTURAL LAY TILE AN PREFLCED S0NC 125003 305 pn H
;"ﬂ:"?ﬂ'\l CLASS MASORFTY LNMS A I 1 rlght pane-
oo oo or carca . smcin 1008 112 m
Eon wwswrs w[: s Using any of these methods, the
il ¥ : c .
— T Section you select will open in the

S| Editor.
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Welcome to the SI Editor

Learning Your Way Around

¥ SIEditor - [d:\sNobs\wigstestipulldata'd7 190n. sec) =[x
M Fis Edt Yiew |naert Format Tools  Window  Halp

&8 Faapasse =080 6 837 @
T EPT TR, TR QST NTM EEG AT ROY NG WR RE D s n—mmﬂnmilll.v

b 3ECrcRTL HARE=SFRFCRELT CONTENT=HIW: -
ARCATCTION 07190 B

T
N,
)

£STLSNATER BEFILLENTS</STLs
CBTES 9 fBTE

CITLEFAAT 1 GCENERALL/TTL

You can access all the o o
functions you need to do FT SR vy i T e s e e by
your editing by us'ng the CEEFr  obGe KEERES AN u'n:::'.--.-u-._:uk-.n':-.:.n: .::“.:-‘..:i“_‘.l”l” =
Editor’'s menus, toolbar v oo 35 o 8 2ot S s e S

ot lond /BTy

and tags bar.

Eile Edit Miew Inset Formmat Tools Window Help |

Many common commands are accessible from both the menus and the toolbar.

R @lGl|a+HE v @

A number of them are familiar Others — such as the commands
Windows-standard functions — to show or hide screen elements
such as cut, copy, and paste. like tags, notes and revisions —

are specific to the Sl Editor.

FRT SFT TTL | TET LST ITH | EMG HMET | REF EID ETL ORG OAD SUB | SRF UREL I

Using a button on the tags bar inserts a pair of the selected

'_ tag. You can either insert the tags then type the information
@ Always edit with the tags vis- between them, or type the information first, select it, then click

ible on the screen. You can the tag button to insert the tags around it.

turn tags off to check the for- NTE NPR TEL TST CHG OTE SCN SCF STL | & B 7 U _Q

matting, but when you make S H o=

any changes, you must see

the tags. Following this rule The tags bar can be customized —

will prevent major errors. you can display only the tags you use
frequently by clicking the down arrow

Use this button to toggle at the end of the bar and checking or

the tags off and on. & unchecking the tag name.
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Tailoring Options

Pre-Editing Your Job

In Chapter 3, we introduced you to the concept of Tailoring
— a way to pre-edit Sections when the Master text preparers
have marked information with Tailoring <TAI> tags. If Sec-
tions contain Tailoring Options, you can choose to leave or
remove all the information within the <TAI> tags — either
throughout the entire Job, or in selected Sections — without
opening any of the Sections in the Editor. This eliminates the

need to manually edit this information in each Section.

It's especially important that you understand Tailoring if you are using

the UFGS Master text, since the

01330 Submittal Procedures Sec-

tion does contain agency-specific
Tailoring Options.

1 You can Tailor an
entire Job by using
the Sl Explorer’s
File menu | Tailor
command.

2 You can Tailor se-
lected Sections by
using the SI Ex-
plorer’s Sections |
Tailor command.

If you open a Section in the SI Editor
that has Tailoring Options, you can
use the Editor’s View menu to select
which to show or hide. There is an
Option on the Tools menu | Options |
Save tab where you can indicate what
you want the software to do with
Tailoring Options that are hidden when
you close a Section — retain them,
delete them, or warn before deleting.

Tailor Sections in.

—alx]

To remove tailored data from within a Section, clear the mark nest to the
Tailor Option.  Clearing at the Section level will clear all the optionz Far
that Section.

[f the 114 Sections selected, 2 Sectionz with Tallonng Optionz are
lisked.

[~ Match check/uncheck on same tailoring optiohs across all sechions

01330 - SLUEMITTAL FROCEDIIRES bdark Al

ARMY (2] —

CONSTRUCTION (9] Clear Al

DESIGN-BUILD  [21)

M2y [19)

[w] 132804 - ASBESTOS ABATEMENT

CLASS LI ABATEMENT - [9)

CLASS Il REMOVAL  [105)

DEMOLITION - [147)

MO DETAIL SHEETS (23]
%
Cancel
Help

[ 1 Mumber of occurences of option in S ection

* Removing Tailoring Options from a
Section is permanent. They cannot be
restored once they are deleted.
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Viewing a Section

Tags, Notes, & Units of Measure

By looking at this example, you can see the advantage of
toggling the tags off to check the formatting.

Just remember to turn them back on before you begin to edit
again!

When you look at a b
Section with the

tags hlddenZ only STEEL JOISTS
the content is 09799
visible. In this
example, you see
only the Section Number, the Section Title, and the Date. The teal triangle at
the left margin indicates that there’s a Note hidden as well.

SECTICN 05211

}{SEC}{HTA NAME=SUBFORMAT CONTENT=NEI:-

Here is the same information <SCN>SECTION 05211</3CN>
with the tags displayed. As
you can see, the Section and <3TL>3TEEL JOIST3</3TL>

<DTE=09f99< fDTE>

meta tags are now visible, in
addition to the tags that

surround the Section Number, Section Title, and Date.
The teal triangle indicates that the Note is still hidden.

¢
Units of Measure

-— You can determine which units

Use this button to view or hide the contents 2 of measure (English or Metric)
of all the Notes in the Section. When viewed, you want to display on the screen
the Note text appears in bold and set apart from the while editing by using the Options
other text by a row of asterisks above and below. tab of the New Job dialog box.

: _ _ _ However, if you want to change
To view the contents of a single hidden Note, click the display while editing, you can
the teal p triangle and the Note contents will dis- do so from the Editor's View
play in a pop-up box. | menu. Keep in mind you do not

e - i need to remove the type of mea-

- surements and tags that you do
not use. When the Job is pro-
cessed and printed, it will only

(o] contain the type of measurement

you choose.
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Using [Revisions

The use of the Revisions feature deserves close attention.
Before you ever begin to edit the first Section of your Job,
you need to know if you are required to show Revisions. This
is an advanced feature, but here are a few basics.

You use Revisions when you need to show the information
that is to be added or deleted without actually executing the change. If you
know that you will be using Revisions when you set up your Job, you can
enable it from the Options tab in the New Job dialog box (discussed earlier
in Chapter 2).

Just how does this feature work? Here’s a portion of text that has been edited with
Revisions enabled:

<TET>The publications listed <bELskelowiDELx form a part of this specification to the
extent referenced. The publications are referred to within the text by the<iDDrir</ADD:>
bhasic designation only.</TET»

o The word “below” was deleted. With Revisions enabled, instead of actually
removing the word, it was instead surrounded by <DEL> tags and displayed in
red strike-through. This indicates that the text is tagged for deletion.

e The letters “ir” were added to the word “the” to change it to “their” so those letters
are surrounded by <ADD> tags and are displayed in green underline, indicating
that they are to be added.

! Don’t confuse the these two buttons!

|
To remove tags
without removing
their content, you need
to disable Revisions.

’— This button actually enables the Revisions
function — if you turn it off, your changes
won’t be marked in the text.

m  This button lets you view or hide the Revi-
1% sions on the screen, in the same way the
tags and notes buttons work. It hides the <DEL>
tags and text they contain, as well as the <ADD>

tags, but displays text between the ADD tags.
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Using [Revisions

[Reversing or Executing from the Editor

But what if you want to change something that has been marked with either
ADD or DEL tags? There are functions to reverse each in the S| Editor. On the
Edit menu, you'll find these two commands:

e Undelete Redlined Revisions will remove DEL tags and leave the text
that had been marked for deletion with red strikethrough.

ShEL=kelowc DEL:

« Delete Added Revisions will remove the ADD tags and remove the text
that had been added in green text.

<ADD=ir</ ADD>

You can use these two commands to either:

 Remove only one occurrence by selecting it, then clicking the corresponding command to
reverse it.

« Remove all occurrences within a Section by clicking the appropriate command without any
text selected.

The Execute Revisions

command in the Editor On the SI Editor’'s Edit menu, you'll find the Execute
makes permanent all Revisions command that you can use for the open
changes marked using Section in two ways:
the Revisions feature. This
action cannot be reversed 1 To accept only one occurrence of a Revision in
by the Undo command, so the open Section, select that instance of text
you must be certain that tagged with either ADD or DEL tags and click the
you no longer need the Execute Revisions command to make perma-
marked Revisions. nent only that occurrence.
2 To execute all Revisions — both ADD and DEL —
In Chapter 5 we’'ll cover within the open Section, click the Execute Revi-
how to use Execute sions command without any text selected.
Revisions for an entire Job
or for selected Sections When marked Revisions are executed, the changes
from the SI Explorer prior will become permanent, and the ADD and DEL tags
to finalizing your Job. will be removed along with the red strikethroughs and
green underlining. The changes now appear as regu-
lar text and will carry the attributes of the tags that en-
close it.
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Begin Editing!

This is it! You're sitting at your computer. You have the
first Section you want to edit open on-screen in the Editor.
-~ You have the printed copy that has been marked with
changes by the engineer. You have determined whether
or not you are required to show the additions and
deletions by using the Revisions feature. The time has
come to edit!

So, with the tags visible on-screen, you locate the first change indicated in
your marked copy.

Here’s an exercise you can do to help you understand why it
is vitally important to only edit when the tags are displayed.

1 Use the toggle tags button to hide the &
tags on screen.

2 Place your cursor just to the left of a Part.

PART 2 FPRODUTCTS

3 Now use the toggle tags button again to | L
display the tags on screen and look at
where your cursor is sitting.

k/SPT =1.5></PRT =1><PRT =2><TTL>PLRT 2 FRODUCTS</ TTL>

"-----------------------J

As you can see from this illustration, the cursor is
not to the left of the Part tag as you might have ex-
pected, but is actually to the left of the ending tag

for the previous Subpart.
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Editing Tips

Adding Information
If you insert additional information into existing
Specsintact’s automated text, the new text will be identified by the exist-
features include a safeguard Ing tags:
to help you avoid tagging
errors. If you attempt to place
a tag in a location
that violates tagging
rules, you will see a
error message.

<TXT> Floor covers shall be maintained.</TXT>
to

<TXT>Floor covers shall be maintained in good

condition.</TXT>

The additional words — “in good condition” —
are identified by the existing TXT tags.

If you were inserting this as completely new in-
formation, you would either:

1 Type your text.
2 Select the text you just typed.

w; 3 Click the TXT button.
Save your changes often! The tags would be inserted surrounding the text.
Not only will this prevent
you from losing changes if you or
have a sudden computer prob-
lem, but Specsintact will check 1 Place your cursor where you want to insert
your work each time you use the text.

the Save function and produce Click the TXT button to insert a set of tags.
a Validate Log if it detects Place the cursor between the tags and type
certain kinds of problems with the text.

tagging. Keep in mind this will
not identify all types of errors,
and you should always run
Reconciliation and the QA
Reports during processing
(covered in Chapter 5).

wWN
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Editing Tips

1

2

Deleting Information

If you delete some of the information between
existing tags, don’t delete the tags. An example
would be:

<TXT>Floor covers shall be maintained in good
condition.</TXT>

to

<TXT> Floor covers shall be maintained.</TXT>

When you remove the words — “in good
condition” — you must be careful not to remove
the ending </TXT> tag.

If you want to remove this information
completely, you would remove both beginning
and ending TXT tags as well by doing one of the
following:

Select all the information including both begging
and ending tags.
Hit the Delete key (check spacing).

or
Place your cursor to the immediate left of the be-
ginning TXT tag.
Hold down the Shift key while hitting the Delete
key (check spacing).

A double-click method for selecting text is illus-
trated in Chapter 6.

The general rule is one blank line between para-
graphs.

After you've edited a few Sec-
tions, it is highly recommended
that you check your editing skills by

running Reconciliation and the
Reports to spot any errors before
you've repeated them in every Sec-
tion of your Job. If you continue to
use these tools periodically as your
Job progresses, you shouldn’t be
faced with as many problems to
correct at the end of the line when
you’re trying to get your Job com-
pleted on a deadline.

Follow the procedures for using the
Reports as outlined in Chapters 5
and 6, and process all the Sections
in the Job (even if you haven't
edited them all). You will only need
to look at and correct errors on the
Reports found in the Sections you
have actually edited (and ignore
the others until those Sections
have been edited). Correcting
these along the way will save you
time at the end!

A common mistake made by new users
is deleting the text between tags but leaving
the tags. Don’t leave behind empty tags!
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Text [Replacement Methods

Using Brackets & Tailoring Options

-_— |
- Brackets are found in some
Master text. They provide you with
the ability to
choose among
several options
of information,
or in some cases, empty brackets
indicate a fill-in is necessary. All
bracketed choices in a Section
must be resolved before process-
ing, and they can be located by
using the Bracket Replacement
button on the toolbar.

a This function will locate
each set of brackets and
give you the opportunity to choose
from bracketed text or enter new

text.

<TETrDrawings will be submitted [30] [60] [920] days
prior to compencement of excavation.</TXTr

|

- We discussed earlier how
Tailoring Options make
specification editing easier by
providing a way to included or
excluded blocks of information
that have been enclosed in
Tailoring tags by the Master
specification writers.This gives
you the ability to easily elimi-
nate requirements that do not
pertain to your Job without
editing them manually from the
Sections.

<TAT OPT=DUST=<TET>Dust and dirt rising during demolition .
However, if

operations shall be effectively controlled by water sprinkling h \
or other approved method. </ TIT><fTAT = you aven't
used the

Tailoring
pre-editing options available
through the SI Explorer, you

| may come across text like this
surrounded with the <TAI>
i tags. It's not too late to use the
Editor’s Tailoring function de-
scribed earlier in this chapter,
or return to the Sl Explorer to
Tailor the Sections on the Job

level. Either way, it's meant to
be a time saver!

A major difference exists
when it comes to using
these two functions with
Revisions:

e The additions and
deletions with
Brackets will be
marked as Revisions.

e When you remove
Tailoring Options,
they will not be
marked as Revisions.
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Formatting

Parts and Capitalization

One of the keys to using Specsintact
successfully is correct formatting. Not
only is this important to enabling
Specsintact to work

properly, but the -
agencies served by When editing Sections in Divisions 02
Specsintact require it. In @ through 16, do not delete any of the
Chapter 3, we covered three Parts, even if you do not need them.
the basic three Parts of  |f they are not applicable to the Section,

each Section, as wellas  they must remain in the Job, followed on
Article, Paragraph and  the next line by the words Not Used in title
Subparagraph levels. If  case (without a period) and surrounded by
you need to, review this <TXT> tags.

material again as you
begin to edit. Keeping
this structure is vital to
producing a correctly
formatted Job.

With tags visible:
<PRT =3><TTL>PART 3 EXECUTION</TTL>

<TXT>Not Used</TXT>

With tags hidden:

PART 3 EXECUTION

Not Used

- Capitalization should be consistent throughout the Job, including the initial
letter of certain specific nouns and of proper names. Some examples would be:

o Contracting Officer - When referring to the representative of a government
agency with authority to make decisions.

e Government - When a government agency is a part of the contract.

o Contractor - When referring to the contractor who is party to an owner-
contractor agreement.
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Formatting

Text and Numerals

Formatting Numbers:

Spell out feet when no inches are used.

(8 feet)

Spell out inches when no feet are used.

(8 inches)

When using both feet and inches, it is permissible
to use symbols.

(8'-8", 8'-2-1/2")

A complete dimension must appear on one line; do
not separate.

Standard designations must appear on one line; do
not separate.

(ASTM C 270, ANSI ASME A17.1)

Use numbers whenever possible, and always for di-
mensions. When defining both quantity and dimen-
sions, use the written word for quantity and the num-
ber for the dimension.

(three 1/2 inch holes)

Always use figures for degrees, percent, and money
(3 inches by 5 inches, 50 degrees F (20 degrees C),
20 percent, $5.50).

Decimals should be expressed in figures.

(6.235)

For quantities less than one, a zero should be used
before the decimal point.

(0.235)

To maintain uniformity throughout the specification,
fractions should be typed using individual keys rather
than the limited number of fraction keys provided on
standard keyboards.

(1/4 and 1/2)

Omit unnecessary zeroes in time and money refer-
ences.

(%200, 9 p.m.)

Chapter 4

The following tags control
text appearance:

e <HL1> Underline

e <HL2> ltalic

e« <HL3>Bold

e <HL4> Center

Don’t confuse these with
the <HLS> tag which al-
lows you to highlight text
(in orange) for on-screen
display or draft printing only
through the Editor. This tag
can be used to call atten-
tion to particular text as the
specifications are being
prepared. The <HLS> tag
has no affect on the final,
processed Sections.




Formatting

Units of Measure and Symbols

- When formatting Metric and English measurements, certain Keep in mind
spacing works best to ensure that the formatting is right when one or = these are guide-
the other of the measurements is hidden, especially during printing. lines that may not
In the following examples, the underscore _ indicates one space. work in all situa-

tions. You should
For mid-line placement: always check the

spacing visually,
especially at the
beginning or end
of a sentence.

your text<MET> 3 meters</Met><ENG>_ 10 feet</ENG> your text

But if it falls at the start of a sentence:

your text<MET> 3 meters</Met><ENG> 10 feet</ENG> your text

Or at the end of a sentence:

your text<MET> 3 meters</Met>ENG> 10 feet</ENG>your text

Punctuation is placed outside the tags:

your text<MET>_3 meters</Met><ENG> 10 feet</ENG>, text

|
Symbol NO-NO List
Because of potential problems, the following should
be written instead of using the symbols:

« percent not %

o

e degree not

e by n_ot?
« per not /
e at not @
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Formatting [Rules

Tables

When you need to insert a table, use the TBL button. It will
place both table <TBL> and table header <THD> tags at
the point of insertion. Here’s a formatted table:

TEL

<TEL><THD>
<HL1>Color</HL1> <HL1>Device Indicated</HL1>
</ THD>
Lmber] ] Full Station
Smoke Detector
Located in:
Fed] 1 Ceiling
Thite] ] UInderfloor
Blue] 1 dhowe Ceiling
Green] 1 Duct
</ TEL=>

Table Tips

f
J Table columns in Specsintact

are separated by spaces (they do
not use tabs or margins to establish
the positions). If you get the first
row set up correctly, it will make the
rest of the formatting easier.

o Formatting tags that you can use inside a
table are those for underline, italics, bold
and center.

« Atable can be located inside a Note (see
the next page for more on Notes) as long
as it does not extend beyond column 70
before it wraps. Don't place <TBL> or
<NPR> tags around a table within a Note.

e When using measurements in a table, the
preferred method is to duplicate the format-
ting and make one for each measurement
(English and Metric). Check your format-
ting by turning off the tags for each type of
measurement separately to ensure clean
formatting for both.
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Formatting [Rules

Notes

When you need to insert a Note, use the NTE button. This will insert Note
NTE|  <NTE> tags, Asterisk <& AST> tags, and Note Paragraph <NPR> tags,
followed by the word NOTE and a colon (:). It should be inserted on a
new line immediately below the previous one (no blank line between).
Here’s what a Note looks like with text inserted:

<HTE >

<kAST>=
<HPR>HDTE: Insert grade or class of compost suitable for
the surface reguired. Insert local or state
regulation defining class or grade of compost.
Yhere local or state regulations do not define grade
or cla=ss, ingert reguirements for =creening to limit
particle size.<fHPR>

<EAST=

< fHTE>

With Notes hidden, only the colored triangle symbol is visible, but
clicking on the symbol will display the Note content in a box like this:

>

S} Specifier Notes x|

HULE:  lnserE grace or class ot coxpost swmatabls for tae anbiacs radulrac.

Tr=art. 1a=al aF SFa=s ¥equlaninm Astir=ag © 558 ar grads ©° fAarpest TheT=
Jucal ovr =zLabe regulabivs o ool Jelio= grade 1 cle==, dp=e:L cegue_cenen =
for =creeninc o l-mit particle =-gze.

When you print with Notes visible, it looks like this:

e e A e e e e P e P o e 2 v ok o e 2 e o o ok o e o o o o e o o e o e o ok o 9 o 2 e 3 o o o o o e o o ol o ol o o o e 9 o o 2 e o e o o o o o o e e
HOTE : Insert grade or class of compost =uitable for
the surface reguired. Insert local or state
regulation defining class or grade of compost.
Where local or =tate regulations do not define grade
or class, insert regquirements for =screening to 1imit
particle =ize.
e e A e e e e e e e e e A o e o e A e o o o e o A oA e o ol o o o ol o o o o e A o o o o o e A o i oA ol o ol o e oA o o o o oA e o o o o o o oy
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[References

Lf
In Chapter 3, we discussed the J

It may help you understand editing

tags that relate to References. your References better if you know
You may need to review that what the end result will be when your
information as you edit. In the Job is processed.
following you'll find an overview of
what you need to know to add or The Reference Article of each Sec-
delete information and tags _ tion will contain the following tagged
relating to References as you edit information for only the References
your Sections. <REF> used in that Section:
e Sponsoring Organizations <ORG>
« Reference ldentifiers <RID>
o Reference Titles <RTL>

</BEF><BEF><ORG=ASPHALT INSTITUTE (AI)</CORG>

<RID»>AI M3I-0Z</RID> <BETL=>(1994; 6th Ed) Mix Design Methods for
bzphalt Concrete and COther Hot-Mix Types</RTL»>

Throughout the rest of the Section,
only the Reference Identifiers <RID>
are used.

RIDs and their content appear in pink:

Z coatz of aszphalt wvarnizsh conforming td:{RID>FS TT-V-51</RID>. >

If you place your mouse pointer over a
RID, a tip box with its corresponding
information will display:

<RID>F3 TT-Y-S51</RID>.
MASA Master Heference [ORG: GSA] = (Rev F) Warnish: ﬂusphalt|

In Chapter 5, we’ll explain more about
processing and what occurs to make
the 01420 Sources for Reference
Publications Section unique to your
Job, while creating a unique Refer-
ence Article in each Section.
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[References

Using [Reference Wizard v i
The Reference Wiz-
ard’s auto open feature

Add|ng References can be disabled by click-
ing the Don’t Show
Remember that you learned in Chapter 3 that the only Wizard Again box at the
Reference-related tagged information that appears in your Sec- bottom of the Wizard.
tion text (outside of the Reference Article) is the Reference
Identifier <RID>.
g
Adding References has been simplified with the introduction of - The Use Empty
the Sl Editor's Reference Wizard. Place your cursor where the Tags checkbox at the
new RID should go and click the corresponding button on the bottom of the Wizard
tags bar. |, will allow you to insert
a set of the tags you
The Reference Wizard will open (if it doesn’t, go to the Editor’s want without any con-
Tools menu, click Options, choose the References tab, and tent between them

click the checkbox to use Reference Wizard). The Wizard will
display the Master Reference lists in the left pane.

% Reference Wizard - Select Reference ldentifler |

1 Click the reference list you want to use and

X . . . . B MASA | [1dantifier [ Tite -
it will display the Organizations. O B ([ acii17  {1990) Standand Specifcation for T
. . . . . . B AR COMDITIC ACIZ1 standard Practics lor Sskect
2 Double-click the Organization and it will dis- B ARDFFUSIC  [@ACI301 tructural Concrets for Buikl
. . . A B AR MOVEME ACI30ZIR | o for Concrats Floos an
play a list of it's RIDs with their Titles B OALUMBUR & |8 ACI304R Measuring, Mixng,
. . B AMERICAM A ACI3D5R Veather Concrating
(although Only the RID, not the Tltle, will be B AMERICAM A [EACI306R Wrather Concreting
i B AMERICAN B ACI 308 dard Prachics for Cuning
inserted at the cursor). B AMERICANG  IBACI315 s and Detalling of Con.
H . JEEHC AN B ACH 318531 %) Building Cox LHTETY
3 Double-click the RID you want to insert. W AMERICANG e LR SO0GR  {101) und for Consaueaon of Co
n M‘Em:ﬁrfﬁ! Baasn N Formmicior Commte M
. . . . . . 1 L] lr__ ci 3
If this RID and its corresponding information is TPt Tt e or A BT EFRUATIONA P01

not found in the Section’s Reference Article, I Dothon Tiewiomdagen I Usingnfon | [ 0% ] _cowd | e |
you’ll be prompted to insert it — click Yes. It
will return you to the Reference Article so that
you can confirm the action. After that, scroll down in the text to
where you inserted the RID to continue editing.

Vg m—— -
You can choose one When you choose a Reference <REF> in the

or more of the listed Wizard, it includes <ORG> tags surrounding the
RIDs by clicking them in name of the Sponsoring Organization, plus RID
the right pane. Hold the and RTL tags. If you don’t select corresponding in-
Shift key to make se- formation for these, blank RID and RTL tags will
quential selections. Hold accompany your selected REF. If you select a RID,
the CTRL key to choose it will be accompanied by the corresponding RTL.
interspersed selections.
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[References

[Removing

Removing References

Removing a Reference that you are not us-
ing in your Section is easier than adding
one. Since the only Reference-related
tagged information that appears in your
Section text (outside the Reference Arti-
cle) is the Reference Identifier <RID>, you
only need to remove the unwanted <RID>
tags and their contents from the text.

- It is very important

that the RIDs in the
text and in the Refer-
ence Atrticle are identi-
cal — including spac-
ing and dashes — to
enable the processing
to work correctly. In-
serting these by using
the Reference Wizard
will help.

You do not remove anything from the Ref-
erence Article of the Section. This will be
handled automatically later when you select
Reconciliation during Job processing.

Having said that, there is one exception to
this rule. If you are using Revisions and
you're are required to show deletions in the
Reference Article, you can edit it manually
to accomplish this.

To check a RID against the Master
Reference list:

1 Position your cursor <RID>FS TT-V-51</RID>.
" between the RID tags. i
J 2 Click the Editor’s Tools menu and

choose Check Reference.

This check occurs automatically when In Chapter 5 we'll discuss
you add a RID to the text of a Section what happens to References
using the Reference Wizard. during the processing of

your Job. Chapter 6 will help
you make corrections based
on the QA Report results.
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Submittals

We covered the tagging of
Submittals in Chapter 3, and
it's important to keep that v
information in mind as you

edit. Here is an overview of

what you need to know when
editing Submittals.

It may help you understand editing your Submittals
better if you know what the end result will be when your
Job is processed.

The Submittal Article of each Section will contain the
following information for only the Submittals used in that
Section:

e SD Numbers and Descriptions

e Submittal Items

Submittal tags and their
content appear in blue.

<L3T><3UE>3D-03 Product Data</3UBr</L3T>
<ITHr>Manufacturer's catalog data shall be submitted for the following:</ITH>

<ITH><3UE>Conduit Piping</3UE></ITH>
<ITH><3UEB>Concrete Mortar</3UB:></ITHM>
<ITH><3UE>Erick Mortar</SUB></ITH>
<ITH><3UB>Gaskets</ 3UB></ ITM>
<ITH><3UE>Compression Joints</SUEB></ITH>
<ITHN><3UE>Frames, Covers and Gratings</SUB></ITH=
<ITH><SUExPrecast Concrete Manholes</3UB:k/ITHM:

As you can see from the example, List <LST> and Item
<ITM> tags are used to provide the proper formatting.

In the text of the Section outside the Submittal Article,
only the Submittal Items are used.

<3UB>Cakhle Supports</3IUB>

This creates a unique Submittal Article for each Section
and allows the information to be extracted for the Sub-
mittal Register.

In Chapter 5, will explain more about processing, what
occurs in the 01330 Submittal Procedures Section, and
how a Submittal Register is produced.
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Submittals

There are eleven different categories for Submittals, called
Submittal Descriptions. They are identified by an SD
Number followed by the Title.

These are found only in the Submittal Article of each
Section, with the Submittal Items listed
under each. In the text of the Section,

only the Submittal ltems are entered, Submittal Descriptions
exactly as listed in the Submittal Article,
and surrounded by <SUB> tags. SD-01 Preconstruction Submittals

SD-02 Shop Drawings

SD-03 Product Data
s
—

A Submittal Classification SD-04 Samples
indicates when Government ap- SD-05 Design Data
proval is required for a Submittal SD-06 Test Reports
Item, and appears only in the Sub- SD-07 Certificates
mittal Article. If a Submittal Item SD-08 Manufacturer’s Instructions

referenced in the text requires ap- SD-09 Manufacture's Field Reports
proval, then its listing in the Refer-

ence Article should be followed by SD-10 Operation and Malntenance Data
a semi-colon, one space, and a set SD-11 Closeout Submittals

of <SUB> tags containing the letter
G. Make sure it is placed inside the
same set of <ITM> tags as the

Submittal
Item.

<ITH><3UB>Fluorescent Lamps</3UBx; <SUBxGE/SUB»</ITH>

Reviewers also are only listed in the
Submittal Article. If you need to indicate
a reviewer, you do so within the same set
of <SUB> tags. Following the Classifica-
tion G, use one separator (you can use
either a space, a comma, a pipe symbol
(D, or a dash) and insert up to five char-

acters. ., 1TMs«<SUEsFluorescent Lamps</SUBs; <SUB»G A/E</SUB»</ITH>
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Submittals

Adding Submittals

Remember that you learned in Chap-
ter 3 that the only Submittal-related
tagged information that appears in
your Section text (outside of the Sub-
mittal Article) is the Submittal Item
<SUB>.

Removing Submittals

Unlike the Reference Atrticle,
you do edit the Submittal Arti-
cle. Therefore, you need to re-
move the Submittal Item
<SUB> from the text as well as
from the Submittal Article if it is
not to be used anywhere else
in the text of that Section. If the
Submittal Item you removed
from the Submittal Article is the
only one listed under that Sub-
mittal Description, then you
should also remove the SD
number and description (along
with tags) as well.

When adding a Submittal Item, it must
be added in both the Submittal Article
(under the proper SD number) and
also in the text. If the SD number for
that Submittal Item does not already
appear in the Submittal Article, then it
must be added there as well, along
with the proper List <LST> and <Item>
formatting tags as outline earlier in
this chapter.

To insert the Submittal tags, use the
button.

sUB

‘: Our engineer gave me a Submittal Item to add to a
Section, but he said it belongs under SD-19. Is this
possible?

No. Since the agencies adopted the Unified Submittal De-
scriptions, only the eleven listed earlier in this chapter that
are found the the 01330 Submittal Procedures Section
may be used. The Specsintact web site’s Knowledge Base
(http://specsintact.ksc.nasa.gov/uic/techhelp.htm) contains
a conversion chart for the older numbers.
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Post Editing Tips

- |
- After editing a Section, check the
formatting by hiding all the on-screen
elements that won't appear in the

Now that you've made printed document — tags, Revisions,

all the text changes, it's notes, formatting marks, and which

time to move on to the ever unit of measure you're not using
for the Job.

automated processes

that make Specsintact With all these hidden, visually check

unique. the formatting of the Section. There
should be one blank line between

But before you do, there paragraphs.

are a few things you _ _

need to check. Before making any changes to adjust

the formatting, don’t forget to turn the

tags back on to avoid inadvertently
deleting any of them.

upport [obLeMS NCOuUNLered

“I've been editing my Section but | don’t see the Sub-
part numbers in front of the titles changing. Why are the num-
bers out of whack?”

Amandain Albany

Don’t worry, Amanda. Remember, your .sec file is your editing
copy. The original numbering of the Section makes it easy to go
back and find information from the original Master text that the en-
gineer marked for you. The renumbering will happen during pro-
cessing (more on that in Chapter 5) and will only appear in your
output files (.prn, . doc., .pdf). Your original .sec will not show the
number changes inside the TTL tags, but you can see what they
will be when processed by placing your mouse pointer over the
TTL tag. A tool tip box will display the new number as it will appear
once the Job is processed.
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Post Editing Tips

'_
If you have been using Revisions,
do not execute them yet.

|/
When you're finished editing,

don’t forget to use the Spell Check
feature. You can access this function
from the Editor’'s Tools menu.

What you learned from this chapter:

+ To edit a Section of your Job in the S| Editor, you always open it
from the SI Explorer.

+ The SI Editor’s toolbar allows you to control which elements are
visible on your screen, and check the formatting by hiding the non-
printing elements.

+ The Sl Editor’s tags bar provides buttons for easily inserting tags,
which should never be typed manually.

+ Specsintact’'s advanced Revisions feature allows information that
that’s being added or deleted to be marked before these changes
are actually made permanent (used when this is a requirement of
the Job).

+ Editing shortcuts can make editing quicker.

+ You should use the Quality Assurance tools (covered in Chapter 5)
periodically as you edit to spot mistakes and prevent repeating
them throughout the Job.

+ Adding and deleting References and Submittals have special rules
for each that, when followed, enable some of Specsintact’s auto-
mated features to work correctly. -

+ When you've finished editing, always run a spell check E]"

3

and visually check your formatting with non-printing ele- ﬂﬁ;
ments hidden. LN ‘.-
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il
Processing & Printing
o S

In this chapter you'll learn:

+ To use the Quality Assurance tools.

What happens when you use the Process feature.

How to locate and correct the problems found on the Reports.
How to produce a finished Job in the output format required.

* & o

apart from word processing programs is its automated
features that help assure the quality of your finished
specifications. The QA tools can help you

A s mentioned earlier, one of the things that sets Specsintact

find problems so that you can correct them

The Process & Print function  petore you commit your Job to paper. As we

includes the Reconciliation mentioned in Chapter 4, it is highly
functions and QA Reports, recommended that you use the

which are key to completing Reconciliation feature and Reports

your Job successfully. periodically as you edit the Sections of your

Job so that you're not faced with editing

errors you've repeated throughout the Job.
Regardless, you should run these Reports
again at least twice before printing — once to find any final
errors, and again to confirm that you've fixed those errors.

The Process and Print/Publish function provides
one-stop shopping for all the tools you need to take

in this multi-function tool kit!
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Sl Explorer

Process & Print/Publish

Since the Process & Print/Publish
command has multiple functions, you will
need to become familiar with it as you work
on your Job, and especially as you finish your
text editing.

You access it from the SI Explorer:

(Eile ) Sediors  Process Miew Tools Selp Help

SIS S| & 4| B

Click your Job folder in the

left pane and use one of the [

following to open the Pro- SRwem [Ro serwmonse e

cess & Print/Publish dialog slue B e e

box: B R R
B R

— Click the File menu and E“;ﬂ el o CAPBG ST, (ST TAAL e

choose Process & Print/ Bom soioms e g

PUb“ShOR = |~ e illhiw:i'.

— Click the Print E

button on the toolbar

" OR

— Right-click the Job folder
J and choose Process &

Print/Publish from the pop-
up menu.

The Print Processing dialog box has
seven tabbed screens

Sectionz |Hepn:nr‘ts | Cther Documents | Optin:nnsl HeaderJ‘Fn:nDterl POF Publizh | Wikl Publishl

If your Job doesn’t If you don’t have Adobe Acro-
contain a cover page, bat, you will not see the PDF/
you will not see the Publish tab, and you must have
Other Documents Microsoft Word installed for the

Word Publish tab to be visible.
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Quality Control Tools

Understanding [Reconciliation & Verification [Reports

To make the correct choices in the Print Processing
dialog box, it is important to understand the relationship
between Reconciliation and Verification — think of
active versus passive.

o Verification Reports are passive in that they only provide information —
reporting errors and discrepancies that are found. Verification doesn’'t do
anything about the problems — you have to fix the errors and resolve the
discrepancies.

« Reconciliation is active because it actually | The three types of Reconciliation
does something — it checks and compares, | — Reference, Address, and Sub-
and then makes changes based on those mittal — are all slightly different,
findings. and produce different results. But

what they all have in common is
These two work hand in hand, so it is important | thattheir goal is to eliminate the

to select Reconciliation to achieve the correct listing of elements that are not
results on the Verification Reports. used in the text of your Job.

Briefly, here are the changes that the three Reconciliation func-
tions make. Keep in mind these changes appear in the output ver-
sions of the Sections, not in the original .sec files.

o Reference Reconciliation only makes changes within the
Reference Article of each Section so that it lists only those

References that are actually cited in that Section’s text.

So what automatic o Address Reconciliation should be used in conjunction with
changes does Reference Reconciliation. It only changes the 01420 Section,
Reconciliation making it unique to the Job by listing only the Sponsoring Or-
produce in the ganizations of References actually cited throughout the Job.

iles?
output files" e Submittal Reconciliation only changes the 01330 Section,

making it unique to the Job by listing only the Submittal De-
scriptions actually used throughout the Job.
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Process & Print/Publish

Producing QA Reports

The first thing to remember when using the Reports function is that to get accurate
results, you must process the entire Job as well as using the Reconciliation func-
tions. Here are the selections you should make on the Sections and Reports tabs:

x

Sections Tab

Sactions | Reports | Other Documseets | Optiores | HeaderFooter | POFPusish | Wond Pubis |

Seledt Sections Periing
j

™ ddmeees
™ Relmences
Subwidtals

Sl Pirt/Frocess Section
Somser | B Pasa

Civmaon (1 40 Civevson U Sctors
U3 SUBMITTAL FROCEDURES
814 SAFETY, HEALTH, AND EMERGENCY RESPFONSE HTRWAST)
420 SOURCES FOR REFERENCE PLBLICATIONS

Divvemsion 02 A Diiion (2 Sectons

All Sections

Print/Process Sections
Renumber Paragraphs
Addresses, References, and
Submittals

023 ewcawaTIRG. RACEFILLING, AND COMPACTING FOR STRUCTURES

22 eecawaTIDN. RACKFILLING, AND COMPACTING FOR UTILITES

0O EMEANFMEMT

02463 WOOD PLES

02473 DRILLED CONCRETE PIERS

02515 WATER SvSTEMS

0535 MEDILM VOLTAGE UNDERGROUND POWER DISTRIBUTIDN
Direectacen 03 A0 Direriaon 03 Saitarc

3525 ESULATIMG COMCRE TE DECKS

FPartee
Hame:  |HF Lasulsl 4100 F3

Print Processing

Reports Tab

Address Verification,
Reference Verification
Submittal Verification,
Bracket Verification, and
Section Verification

fl‘mu

| Subwinsl Regisies

™ Teat Bequinemert Lint
Seleci Al | Uensiect & |

Pt
Mo [acicka Distler

After you’'ve made these selections, click the

Process Only button to create the electronic

files for your Reports (.rpt) and processed
Sections (.prn).

If you select Process and Print, it will send

your entire Job and the Reports to your printer

in addition to creating the electronic files.

Proceszs and Print |

Frocess I:Inl_l,l

Save Seftings

Cancel

Help
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Quality Control Tools

Viewing & Printing Reports

v,
The Report results J You can print any of these reports
can be found in the -l QE=EEI from the SI Explorer by selecting the
Processed Files ones you want from the right pane and
folder under your Job in the SI clicking Process & Print again.

Explorer’s left pane, with the
contents of the folder displayed in
the right pane with an .RPT

file extension. FZ[ ADDRVER RPT ADDRESS VERIFICATION REPORT
| BRKTVER RPT BRACKET YERIFICATION REPORT
| DUPEREF RPT REFERENCE VERIFICATION REPORT
P | REFVER RPT REFERENCE VERIFICATION REPORT
FE| SECTVERRPT SECTION YERIFICATION REPORT
| suBnvER RPT SUBMITTAL YERIFICATION REPORT
B TTLDFFS RPT REFERENCE TITLE REPORT

The Report files (.rpt) can be opened in the Sl Editor just like Section files. When you open
a Report, you'll either see that there were no problems found or it list any that were. The
listed problems are hyperlinked to the Sections where they appear — just double-click and
the Section will open with the cursor placed at the location of the problem.

‘: Will it affect the results | see on the Reports if | don’t
check the boxes to perform Reconciliation?

Yes, Reconciliation does effect the Report results. That's
why the Reconciliation boxes need to be checked any time
you produce the Verification Reports — and all Sections in
the Job selected for processing — otherwise, you'll see re-
ported errors that would be taken care of automatically using
the Reconciliation process.

Keep in mind that the changes resulting from Reconciliation

are only seen in the output files (prn, pdf or doc) — your
.sec files remain unchanged.
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Viewing [Report [Results

So now that you've produced the Reports, what do they show you?

In Chapter 6 we’ll show you in more detail how to use the various types of
Report results you may encounter. For now, it's important to learn how the QA
process works.

Here’s a sample of the kind of results you might see on a Section Verification
Report. The top portion explains the type of problem, followed by the list and
locations. These are hyperlinked to the Section so that all you have to do is
double-click and the Section will open in the Editor, and locate the cursor at the
Subpart with the problem.

In this example, you would need to show the list to your engineer to determine
how to resolve these issues — by either adding the missing Sections that are
being referenced, or by eliminating the references to them.

Thiz report listz all ZSectionz that are referenced in other Sections, bhut
that are not in the Jokh or Master.

SECTION  SUBPART SECTION REFERENCED
! 05095

0531z 1.4 05095

06200 2.2.2.1 08710

14500 0.4 05095

14500 1.7 09970

15119 1.3 15003

15119 3.1 15050

16286 1.3 16003

16286 z.12 09960
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Viewing [Report [Results

Here’s another example. This report shows that
some of the bracketed choices have not been
selected. In this case, you would locate the
error, check your marked-up printed copy to
determine whether your engineer had marked a
selection or entered information. Each set of
brackets in the Sections needs to be replaced
with text and the brackets themselves removed
before the Job is complete.

BRACKET VERIFICATIOH REPORT

0z311
ozsil
02311
02311
0311

[ T I o o Y Y -

Always check first to see if a problem is
simply the result of a typo.
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Viewing [Report [Results

When no problems are found — your goal
before the Job is complete —

the Reports will indicate that no
errors or discrepancies remain.

This report lists any Reference Organization that appears in a Section
Feference Article without a corresponding listing in either the Jources for
Feference Publications 3Zection 01420 or the 3upplemental Reference List.

HIMT: Double-clicking a Section nuber will open the ZSection in the Editor.

SECTIONH REFEREHCE ORGAHNTZATION

ALL EEFERENCE ADDRES3ES HAVE BEEN VERIFIED

Keep in mind that in the case of both Submittals and References, the listing must

be identical — including spaces — in the text, the corresponding Submittal or Ref-
erence Atrticle in the Section, as well as in the 01330 or 01420 Section. Otherwise, they
will appear on the Reports as discrepancies.

One major difference is that References are case sensitive, while Submittals are not.

Chapter 6 has details on fixing the different types of errors
and discrepancies you may encounter on the Reports.

"6, Specsinect Chaptar 5



Other QA Tools

Submittal [Register and Lists

In addition to the Verification Reports, you can
also produce several lists and the Submittal
Register from the Reports tab in the Print
Processing dialog box.

Reports Tab

Print Processing
Sactions  Fieperts | Ofher Documents | Opbons | HesderFooter | PEsPusizh | Word Futah |
Eaawerk: s P
& [Pacgch T.shis of Contents
[ Reckibess Winshcation = o Faosess Dy
I Asttimee Ve =k —
I Subaing Veshcstion ™ inchuda vihou Scope
I Bracket Verfcation [~ Lish ary usmed dvisiora in [
r e propesct Sabke of conteniy
- bk
St Toble of Contants
[ irchuda with Scope
I frchuds waifend Scope
i Lombma mchions and sachan
Uneleci Al | [T pr——
B
Marm:  [icackar Distber =i sse. |

After you've made
these selections, click
the Process Only
button to create the
electronic files for your
Reports (.rpt) and

Process and Print |

Reference Location List

Itemizes all the References cited in
the text, followed by the Section and
Subpart locations where they are
found.

Submittal List

Itemizes all the Submittal Descrip-
tions found in the Sections’ Submittal
Articles, along with the Section and
Subpart locations in which they are
found.

Submittal Register

Lists the materials, products or items
for each Submittal, as well as the
Section and Subpart locations in
which they are found.

Test Requirements List

Itemizes all the test requirements
cited and includes the Section and
Subpart locations in which they are
found.

Frocess Only

processed Sections

(.prn). Save Settings |

If you select Process and Print, it Cancel |

will send your entire Job and the e |
Help

Reports to your printer in addition to
creating the electronic files.
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Baclkup Your Job

Using the Backup function to make a copy of your
Job is a good idea any time — especially before
executing Revisions, since once these marked
changes are accepted, the they are permanent and
cannot be reversed by the Undo command.

A W N P

From the SI Explorer’'s File menu, click Backup/Restore/Manage.
From the Backup screen, click the Jobs tab.

In the text box, select the Job you want to backup.

In the Include in Backup area of the dialog box, check the boxes if
you want to backup any Processed Files, PDF Files, and Word
Documents that are part of the Job.

In the Backup to (Destination) area of the dialog box, choose the
Drive from the pull-down list.

In the Directory box, click to select the folder in which you want to
save the backup.

If you want to create a new folder for the backup, add it to the end of
the path by typing a backslash (\) and a folder name in the Backup
Path text box.

In the Backup Type area, select either of the following:

« Normal Format — Makes individual copies of all the files con-
tained in the Job.

e Archive (Zip) Format — Compresses all the files into a single file,
requiring less space (required for the e-mailing function on the Re-
store/Send tab).

Checking the box for Delete Existing Files in Backup Directory will
delete any type of files (not just previous backups) that already exist
in that folder and should be used with extreme caution.
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Executing [Revisions

Now that you've used the Backup feature to make L E:L r'f;i}’
an archive copy of your Job, and you’ve made all & ;
the corrections found on the Reports. If you have

not used the Revisions feature, you can move on to

the next page to

IPera(l)rQechJv(\éLtgrim To accept all the Revisions that you've marked throughout the entire
your Job Job (both additions and deletions):

1 Click your Job folder in the left pane of the SI Explorer.
2 Click the File menu and select the Execute Revisions command.

However, if you've 3 The resulting dialog box will list all the Sections in your Job and give

used the : . . .
Revisions feature you to opportunity to _choose any Sections in vv_hlch you want to re-
while editing tain the Revisions. Click a Section to deselect it and keep its marked

Revisions.

4 Click OK and the marked Revisions in all the Sections remaining se-
lected on the list will become permanent. The ADD and DEL tags
will be removed along with the red strikethroughs and green under-
lining. The changes now appear as regular text and will carry the at-
tributes of the tags that enclose them.

it's now time to turn
the ADD and DEL
tagged changes
into permanent
text.

To accept all the Revisions in selected Sections:

1 Click your Job folder in the left pane of the SI Explorer.

2 Select one or more Sections from the right pane.

3 Click the Sections menu and select the Execute Revisions com-
mand.

4 The resulting dialog box will list all the Sections you selected and
give you to opportunity to deselect any in which you want to retain
the Revisions.

Click OK and the marked Revisions in only the Sections selected will

become permanent.

w After you Execute Revisions, the files that have been permanently
changed by this function are temporarily displayed in the left pane of the
S| Explorer in a folder called Revised Files, located under the Job folder.
These are the actual Section files, so do not delete them from this folder
or they will be permanently removed from your Job!
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Printing Your Job

You've arrived! You've now reached the point where
you want to produce your Job’s edited Sections in
their final format — all the changes, no tags, perfect!

Once again, you'll use the Process and .
Print/Publish command on the SI Explorer’s File menu or the
&5 J

corresponding button on the toolbar. This time, you'll make
different selections than you did when you accessed this box to
produce the Reports. It's important to understand how to make the right
choices so you can achieve the exact results you want.

As we mentioned before, the .sec files are your editing copies of the
Sections — they are used to produce your final copy. We've discussed
the processing that occurred as you used the QA tools from the Process
& Print/Publish function. But instead of using the Process Only button as
you did before, you’ll now use the Process & Print button.

But before you click that button, you want to make certain that the
settings on all the tabs are correct to produce the Job the way you want.
In addition, you may have been asked to deliver the electronic files in
Word or PDF instead of Specsintact’s .prn files — the two additional
output formats that can be produced through Specsintact , as long as you
have the corresponding software.

Sections |Hepu:ur‘ts | Other Documents I Optiu:unsl HeaderJFu:therl FOF Publizh | Wiord Publishl

By this time, you should be familiar with the first two tabs of the Process
& Print/Publish box, but you'll now learn how to use their settings to pro-
duce your Job. In addition, you'll see how the settings on the Other Docu-
ments, Options and Header/Footer tabs are used to determine what
your output files contain. And finally, you'll learn about the settings you'll
use if you choose to Publish your Job in either PDF or Word.
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Process & Print/Publish Settings

Sections & [Reports Screens

v,
J If you want to save some but

not all the settings made on the
On the next few pages, we’ll various screens of this dialog box,
show you the settings and make the ones you want to save
choices you should make to first, click the Save Settings but-

. ton, then make the additional se-
produce your final, processed lections that you want to use for

and printed Job. just this printing.
Scctions Tab Print Processing B
« All Sections e e e
. . Sbact Gactiong Parting snd Rerurmbenng Reconcls
e Print/Process Sections s e I Addesces Process Dy
« Renumber Paragraphs F somatacins | | PemmbmPespute Myt p—
e Reconcile Addresses, References, [T e ey vy - Cwcsl |
. N30 SURMITTAL PROCEDLIRES
Submittals m?:-%-: SS;EEE;SI-::E;&'. rH'F:gE EEAEF;EF NET RESPONSE [HTRWAIST] =
. . 4z L5 REFEREN EILICATIONS |
« Choose Printer from drop-down list DT sreavaTie, BACETLLING, AND COMPACTING FOR STRUCTURES
(If you plan to produce the output Gom) EusamEnt A CONPACTING FORUTILTES
. . . . 463 wiOD PRLES
files in Word you can skip this step.) (@473 DAILLED CONCRETE PIERS
02515 WATER SYSTEMS
nﬂﬂgﬂﬁﬂéﬁﬁgﬁﬁﬂEﬂﬁﬁﬁﬂm FOWER DISTRIBLITION
0352 BSULATING COMCRE TE DECKS |
P
N [HF Lassdel S100F5 = __se |

Print Processing RGPOFTS Tab
s«:om Rsperts | Ctner Documents | Ootions | Hesderonter | POFPusteh | wers Fustan | e mien || ©  Submittal R_egister, if required
R — Prciec T o Conkerts eesny || * ANy Of the Lists requested by your pro-
I~ Relseece Vestcatin e e ject engineer
[ e "*"‘““”*";i;"; — o All Verification Reports (Run again to
skt Werhioshion List [LLP Ll .
o T e st o covves double check that all issues have been
erific-or: Help
I~ Ralsserecs Locason List Section Tkl of Conbents reSOIVed.)

:5*““;“ . I tochude wih Scope e Make Project and Section Table of
Srburaial e . .
e R Contents selections based on require-
soectia | bt | || o e ments (Scope is a brief description).

Pt
Heme [-?l.n:lnl:-r[l-:llﬂ li 4“"“
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Process & Print/Publish Settings

Other Documents & Options Screens

Print Processing

Sactions | Fepons  Cerer Documents | Optons | Mesgerooter | A0 Pussst | wara Pubesh |

% Other Documents Tab

Ecsz etk aied Prink °

Proceis Ory |

™ Prind 51 Docussenis eleched balowr Sarve Setirgn l

I~ Dmitbader and boater bor Dther Documents — l

| Dozt [ Tote [ Bate Modiied I Help !
B% cover 117,00 1:45 pm

If you created a Cover Page to include,
in either .sec or .rtf format, you will see
this tab. If you do not have a Cover
Page, this tab is not visible. Check to
include the cover with the Job. Covers
can be added using the S| Explorer’s
File menu | Properties | General tab.

Options Tab

e Section Dates (if required)

e Units of Measure (you must choose

English or Metric since a Job can-
not be printed with both)

e The starting Page Numbering can
be changed

e Select whether you want each Sec-
tion to start over with it's own num-
bering

« Print Range All Pages

Print Processing

Sactons | Feports | Othes Documerts  Cptions | Headen#ooter | PEF pusish | vord Fuban |
Erecats and Pt
S Lirsts of Mesgine
[ EsclinDales [ | Flavisions 1 Ergizh Praceit Ordy
[~ Hotas: [~ Tags L Ser Selings
‘ol !
Fage Huberig — Concel
Shateg Paga Nunber. [T r AP b
™ Reitat o sach Secton ™ From |'_ To |_
Pambet
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Process & Print/Publish Settings

Header/Footer Screen

Header/Footer Tab

Make any changes to Headers or
Footers (see tips below). The de-
faults reflect the standard require-
ments for printing a Job.

Pipe (|) symbols control the
horizontal position of the text in the
header and footer lines. The pipe
symbols are inserted by using the
Shift and \ (backslash) key. Here
are the formatting rules:

e To center, place text between
two pipes: [this text will be
centered|

e To align left, use no pipes:
this text will align left

e To align right, place two pipes
to the right of the text: ||this
text will align right

e To align both right and left,
place two pipes dividing the
text: this text will align
left||this text will align right

e To center and align both
right and left, use pipes to di-
vide: this text will align
left|this text will center|this
text will align right

Print Processing

Sactions | Fieports | Other Documerts | Optons  HeaderFater | PoFPusish | Waord Publzh |
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ers, here are two tips to help you

When setting headers and foot-

with formatting:

The vertical position can be
changed by entering a different
number in the Start at Line
Number box (header default is
4; footer default is 62).

Change the first line or add a
second line for either header or
footer by using the Variables
box.

So just what is a Variable? Think
of it as a place holder. It represents
the information that will be placed
on each page in the location indi-
cated.



Process & Print/Publish Settings
PDF Publish & Word Publish Screens

Creating PDF or Word files is called Publishing since it produces electronic files
that can later be printed on paper through the S| Explorer. Once published, they
can be found in PDF and Word folders under the Job in the Explorer’s left pane.

PDF Publish Tab

Print Processing

Sections | Beports | other Documents | Cptions | Headerfocler  POFPuBsh | viordPutash |

« |If PDF output files are required, select o F——
the desired settings. The electronic files o ettt b = R—
produced will be visible in the left pane I Pt evisting POF fles urdessrahoced v newes versions .
of the SI Explorer under the Job in a B —
PDF Files folder. Your Adobe Acrobat I A S ochon rsmbas 1o Seckices o of omiets boodmak -
software should be chosen from the L wﬁﬁmm_mﬂww
Printer drop-down box (hames will vary e e S
by Adobe version).

Pania
Harrer Ea.clmlln:llei LI —Iﬁ-_:h.n
Word Publish Tab

« If Word output files are required, select s | s | onsoimes | s vt | sormssn vosmwin | =
the desired settings. The electronic files "= —
produced will be visible in the left pane o £ [ o mnres o ey e - e
of the SI Explorer under the Job in a : |
Word Files folder. When Word is se- e Coackodfes b thaacy bow coned =

L

lected for output, the Printer box is no
longer visible. Only Section files can be
published in Word, not the Tables of
Contents or Reports. -

CBrocess and Pin |

Frocesz Only |

After you've made all your
selections, click the Process and
Print button. If your choice of
output format is PDF or Word,
then the button will say Process

Save Settings |

cancel || and Publish, indicating that the
files produced will be electronic
Help || and not printed on paper.
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Printing PDF and Word Output Files

" If you use the Publish
function to produce either
PDF or Word electronic
files, you may want to print
a hard copy. You can do this from the
S| Explorer — either for all the
Sections that you have in the output
folder or for selected Sections.

1 Click the output folder
in the left pane (PDF
Files or Word Files) to

Specsintact - MYJOB
i rocess  View Tools Seup

|| W | B @ |

v,
J If you find additional

changes you need to make,
you can rerun the Process &
Print function again — just
keep in mind that the previous
output files — processed Sec-
tions (.prn), PDF (.pdf), and
Word (.doc) — will be replaced
by the new ones (the excep-
tion is if you chose the option
to retain previous files on the
PDF screen).

display its contents in [avatate Profects Forterts of WvI0B: POF Faes’
the right pane. & B Jos %m ETTE
H H bl [l "METAL STAIRS*
2 ('_\’“Ck anywhere in _the 07131 o pelt *ELASTOMERIC MEMBRAME WATERFR
right pane, then click Thaags peit BITLMMOLS \WATERPROCFNG
the Sections menu 1]

i 2|
[3Fies mar

and choose the Select
All command. You can

also choose only se- =10] X
lected Sections from
the right pane if you iﬂl "lil E] ¢| ‘
don’t want to print them [Rvasatte Frofects Forterts of MYJ0B: Wiord Fies

. all . B %;hswm - ;n‘n T —

3 Click the Print e ssonFlat j "METAL STARS® .
button to send & ~ @ “m”mﬁ‘éﬁl@
the files to your & -||4] i |
default printer. [Mva08 My LFGS Test Job [3Fhes foras

You can also print the Pro-

cessed Files (.prn) in the
same way.

Chapter 5

If you edit your Word out-
put files, these changes will
not be reflected in your source
.sec files, so if you subse-
guently generate new Word
output files, your changes will
be lost.




upport robLeMS

“Help! | changed my headers and footers, but when |

went back to Print & Process again, the changes were gone!
What happened? Do | have to reset the headers and footers
every time | process?”

Karen in Kansas City

No, you just needed to save those settings to make them your new
defaults. If you open the Process & Print/Publish dialog box and
go to the Header/Footer tab, you can make any changes you
want, and then click the Save Settings button on the right. Keep in
mind that doing this will also save any other changes you’'ve made
since you opened the dialog box, and they will become the new
defaults. It's a good idea to make changes you want to keep first,
click the Save Settings button, and then continue to make one-
time changes you don’t want to save as your defaults.

By now, you have been through all the

' major features of Specsintact that you

) need to use to produce your Job suc-
cessfully.

As with all software, there are many
factors that can affect how you need to
adapt as you work. In Chapter 6, we’ll give you
some additional tips and cover just a few of the ex-
tra features found in Specsintact that can help you
use it to it’s full potential and yours!
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What you learned from this chapter:

¢

There are a variety of Quality Assurance tools to assist you by
checking the various elements of your Job. They are accessed
through the Process & Print/Publish function.

Reconciliation actually makes changes within the Job, while Verifi-
cation only locates errors and discrepancies that need to be re-
solved and displays them on Reports.

By viewing the results of the Reports, you identify the errors and
discrepancies found, and hyperlink to their locations so that you
can resolve them by first checking for typos, then consulting with
your engineer if the issue involves technical content.

Reports should be rerun until all problems have been eliminated.
Additional lists and the Submittal Register can also be produced
through the Process & Print/Publish function.

Specsintact has a Backup feature that lets you make an archive
copy of your entire Job.

If you are require to use Revisions, you need to execute them prior
to the final processing of your Job. It's recommended that you
backup your Job before executing Revisions, since those
changes will become permanent. .
After all the Reports are clean, you use the Process & Print/
Publish function to produce your Job in the desired output
format.

Chapter 5

As always, if you have questions or encounter problems,
we provide live tech support Monday - Friday, 8 a.m. -
4:30 p.m. (EST).

The support email is specsintact@jbosc.ksc.nasa.gov. ||
You can reach them by phone at 321-867-8800,
or fax at 321-867-1444.
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~
Tips gfl'ools

In this chapter you'll Iearn:

How to use other handy tools that come with Specsintact.

Tips, shortcuts and editing techniques to make your work easier.
Proper use of symbols and capitalization.

How to fix errors and discrepancies that appear on QA Reports.
What information the Lists can provide.

How to restore a Job from an archived backup copy.

How to use a checklist to make sure you're ready to deliver the final
Job.

*® & & O O o o

n this chapter, we’ll present some ¢ : .
l additional tips and tools that may As you contmu’e to work_ln
help you more effectively produce Specsintact, you'll find which
a finished Job. As we said in the intro- m_ethods work best for you. As
duction, this QuickStart Guide is not with most software, there_are sev-
intended to cover every aspect of us- eral ways to access functlons an.d
ing the software. You should use it in perform ta}sks_. With a little experi-
conjunction with the other user tools ence, you Il discover how to
provided with Specsintact and on our streamline your work process.
web site.

Some of the pages in this chapter are
designed to be printed as quick refer-
ence charts that you can keep at your
desk as you work. There are also
pages dedicated to helping you fix the
errors and discrepancies found on
each of the QA Reports.
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More S| Tools

In addition to the features we’ve covered in
the previous chapters, Specsintact has
some other handy tools you can choose to
use along the way.

Keeping Track
Here are tools you might find use-
ful in tracking some of the infor-

Customizing Your View .
mation about your Job:

Here are a few changes you can make to
adapt what you see on your screen in the

Sl Explorer: e The Job Properties box —

accessed from File menu |
Properties or toolbar
button — has three
handy tabs for tracking
information. The Schedule
screen lets you keep track of
review status, dates and hours
expended. The Specifiers
screen lets you assign differ-
ent engineers to specific Divi-
sions. The Comments screen
allows free-form entry that
adds an automatic date/time
stamp to each. The Properties
box also has a Print button in
the lower left so that you can
produce a printed copy of this
information.

e You can use Setup | Options
| Specifiers tab to make a

O reusable list of Specifiers that
Choosing to display some of the column will be available from the drop-

headers — particularly Date — may down boxes on the Specifiers
cause a slow down in the speed with which screen mentioned above.

the Sections display in the SI Explorer. This
is especially true with large Masters.

e Column Headers — by using the
View menu, you can change the in-
formation that appears in the right
pane of the SI Explorer by either
adding to removing Column Headers.
(See caution below)

e Setup menu | Options | General tab
— allows you to adjust settings that
control various functions, as well as
resetting some defaults.

e Colors — You can change the color
of the Job, Master and file icons by
right-clicking on them and choosing
the icon color option from the right-

Chaptar & O Shcie 7



More SI Tools

Emailing Files
It's always a good idea to make a
backup of your Job files, and it's a
good way to archive a finished Job.
But this same function also provides
a method for emailing your entire Job
in the .zip file format. The Backup/
Restore/Manage box can be ac-
cessed from the Sl Explorer’s File
menu. You must first make the
backup copy of the Job, then select it
for emailing. Due to file blocking at
NASA, if you're sending a Job to Sl
Tech Support for problem resolution,
you must change the file extension
(for instance, change from .zip to
.zap). If you're emailing it elsewhere,
the.zip file format should be accept-
able.

To email Section files, select them in
the SI Explorer’s right pane and
choose the Sections menu | Email
command. With this function, they
are sent uncompressed in the .sec
format.

Templates

You'll see two different types of
templates used in Specsintact.
You can access both from the Sl
Explorer's Tools menu.

Section Templates —
Outlines used as guidelines
for creating new Sections.
The option to create Section
templates on the Tools Menu
should be used to create
unique Section outlines, not
new Sections. New Sections
can be created from Add
Sections dialog box.

Sl Document Templates —
Blank document which may
be used to create a cover
sheet, project information
sheet, sign-off sheet, or
other unique document to be
used with specifications.

Chapter 6




F g ———
Keep in mind that in the SI Explorer,
the File menu commands are for Job or
Master level actions, while the Sections
menu commands pertain to individual or
groups of Sections.

S| Editor Format Menu
Formatting commands you can access
from the Editor's Format menu are:

S| Explorer Help Menu
From the Help menu you can access the
following:

e Font
o On-Screen Help — Features an Ex- e Margins
plorer view that displays topics in the e Change Case
right pane and a table of contents in the e Toggle Indentation
left pane, as well as offering search ca- e Indentation Amount

pabilities.

e QuickTours — A basic series of graphic
overviews of the fundamentals of Spec-
sIntact that can be viewed on screen
(with printable versions on our web site).

e Sl Web Site —Link directly to the Spec-
sIntact web site resources to download
software and Masters, view the Knowl-
edge Base, and keep up on new devel-
opments regarding the software.

o About Specsintact — Allows you to
check the Sl version number you are us-
ing, and documents where Specsintact
is installed on your system (both impor-
tant when contacting tech support for
assistance).

You should use Font and Margins
changes with caution since these are
global settings that will affect every Job
and Master you have. Check the Help
topics for these commands to learn more
before deciding whether to make changes
to the defaults .

I Remember that the right-
click menus change de-

pending on the actions avail-
able in any given situation. If
there is something you are try-
ing to do, and you don’t know
how to perform the action, try
¢ right-clicking to see if there is
Don't forget that you can customize the Editor’s a menu option for it.
Tags Bar to display only the tag buttons you use
frequently. Use the down arrow button at the

right end of the Tags Bar to add or remove -
buttons from the display.
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Shortcuts

Sl Editor Keyboard Shortcuts

Open Ctrl + O

Save Ctrl + S

Print Draft Ctrl + P

Undo Ctrl + Z

Redo Ctrl+Y

Cut Ctrl + X

S| Explorer Keyboard Shortcuts Copy Ctrl +C

New Job Ctrl + J Copy without Tags Ctrl + E
New Master Ctrl + M Paste Ctrl + V
Add Sections Ctrl + A D_elete Ctrl+ D
Process & Print Ctrl + P Find Ctrl + F
Edit Ctrl + E Find Tags Ctrl + |
Search & Replace  Ctrl + F Replace Ctrl + H
Delete Delete key Next F3
Screen Refresh F5 Revisions On/Off Shift + F8
Options F2 Page Break Enter key
Help F1 Insert Tags F4

Spell Check F7

Help F1

To toggle the following screen ele-
ments on or off:

Tags Alt+S
Notes Alt + N
Revisions Alt + R
English Units Alt + G
Metric Units Alt + M
Both English/Metric  Alt+B
Marks Alt + A
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Editing Techniques

Double-clicking to Select Text

You can double-click on an individual word to select it.

</8PT =2.2.6<3PT =2.2.7»<TTL>2.2.7 Hanger</ TTLx>

<TET>Provide clips or loops for [utility systems] [and] [suspended ceilings] of
one or more of the following types:</TXT»

<ITM INDEWNT=-0.33>a. Lip tabs or integral tabs where noncellular decking or flat
plate of cellular section is<ENG> inch</ENG> thick or more, and a

structural concrete £ill is used over deck.</ITH»

<ITM INDENT=-0.33>d. Decking manufacturer's standard as approved by the Contracting
Officer.</ITH>

</3PT =2.2.7»<3PT =2.2.8»<TTL>2.2.5 [<3UB>Mechanical Fasteners</3UE»</TTL>

Continue double-clicking to expand the selected area
to include the surrounding tags.

</3PT =2.2.62<3PT =2.2.7»<TTL>»2.2.7 Hanger</ TTL>

<TET>Provide clips or loops for [utility systems] [and] [suspended ceilings] of
one or more of the following types:</TIT»

<ITH INDENT=-0.337a. Lip tabs or integral tabs where noncellular decking or flat
plate of cellular section isg thick or mwore, and a
structural concrete £ill is used over deck.</ITM-

<ITH IMNDEMNT=-0.33>d. Decking manufacturer's standard as approved by the Contracting
Officer.</ITHM>

</3PT =2.2.7#<3FT =2.2.8><TTL»2.2.5 [<3UB>Nechanical Fasteners</3UE></TTL>

Copere



Editing Techniques

Double-clicking to Select Text

Double-clicking again inside the selected block of
text will expand the selected region to include the
immediately surrounding text and pair of tags.

<fBPT =2.2.6»<3PT =2.2.7><TTL>2.2.7 Hanger</TTL>

<TET>Provide clips or loops for [utility systems] [and] [suspended ceilings] of
one or more of the following types:</TIT>

e noncellular decking or flat
thick or more, and a

or integral tabs wh
0.0474 in
r dec

<ITH INDENT=-0

<ITM INDENT=-0.33>d. Decking manufacturer's standard as approved by the Contracting
Officer.</ITH>

</8PT =2.2.7»<SPT =2.2.8><TTL>2.2.8 [ </ TTL>

You can precisely select an entire Subpart (or TXT paragraph, PRT, RID, ORG,
etc.) simply by positioning the cursor on any word in the entire Subpart, and
then continue double-clicking. Each time you double-click, the selected region
will expand, until you have selected the entire Subpart. If the start of the se-
lected region is not on your screen, the Editor will automatically scroll there. You
can use this feature to select levels up to an entire Part (but you cannot select
an entire Section by this method).

Hanger</ TTL>

temz] [and] [suspended ceilings] of

0.0474 in

Decking manufacturer's standard as approved by the Contracting

</ TTL>

v,
J If your goal is to select an entire Subpart, double-clicking within
the Subpart Title is the fastest method.
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Editing Techniques

Sclecting and Deleting

Keystrokes for Selecting Text
e Shft + Right or Left arrow — selects one character at a time.
e Shft + Ctrl + Right or Left arrow — selects one word at a time.
e Shft + End — selects from cursor to end of a line.
e Shft + Home — selects from cursor to beginning of a line.
e Shft + Down or Up arrow — selects one line at a time in the applicable direction.
e Shft + PgDn or PgUp — selects a page at a time in the applicable direction.
e Shft+Ctrl + Home — selects from cursor to the beginning of the Section.

e Shft+Ctrl + End — selects from cursor to the end of the Section.

You can delete tagged text using the Shift and Delete keys.

The Shift and Delete key combination can be used to delete an entire
tagged element (including any other tagged elements nested within the
selected tags). To use this function, the Editor must be in the View Tags
mode. Position the cursor immediately to the left of the beginning tag of
the element you want to delete, hold the Shift key and press
the Delete key. The beginning and ending tags will be
deleted, along with everything in between.

\lf Flace cursor here

T}FDI portions of the building Lo remalin, protect

puilding interior and materials and equipment fromw the
weather at all tinmes. Where removal of existing roofing is
necessary to accowmplish work, have materials and workmwen
ready to provide adedquate and tewporary covering of exposed
areas =So as to ensure effectiveness and Lo prevent
displacement.] </ TET»
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Fixing QA [Report Errors and Discrepancies

Using the Reports to
identify, find, and fix
problems in your Job is
key to producing final
specifications that are
accurate and complete.
In the next few pages,
we’ll illustrate some of the errors and dis-
crepancies you may find and tell you how
to resolve them.

|
Don't forget, the keys to getting ac-
curate Report results are:
Make sure your Job contains
Sections 01330 and 01420.
Process all Sections, not just
some Sections
Choose all three Reconcile
(Address, Reference, and Sub-
mittals) checkboxes from the
Print Processing Sections tab.

- After processing, the Reports reside in your Job’s Processed Files
folder. Click this folder in the SI Explorer’s left pane to display it’s files in

Print Processing
| cmtons | Hesder®ooter | PoFPubsh | Word Puidah |
Paciect T shis of Contents
Faocess Orniw I
T drechucks with Soops
I Srvude withou Sccpe __ Semiesnn |
[ Lish any urwased divisiona in Cancel I
Frvr progect Rable of conbenby
b |
Sction Toble of Contengs
I Subwsiad sk ™ Svude with Scopa
[~ Sabwanst Fiegiien
I ks wibond Sieope
™ Tl Paquinsmend Litt
[ Cormbma metions snd anchion
Selectall | Wiemeectid | Radshak ol ecuthiits
Pinies .
| Hamer  faciobar Dintiler .ll _Ein' = |
Print Processing =]
Sections | Rrpaets | Corne Documerts | Options | HeadesFooter | FoF Pusisn | werd Butiar |
Peocers and Pk
Gbett Ethion Poriing snd Farmmbanng Aevarcis
I~ PirtFrocess Sechons I™ Addesces Fyocers Onip
™ Relmences
™ Soma Seckons I Fanambe Pasgraph Subials £y Saliings
L reepaceny U1 40 Cireviacny U] Semciuoes; - Carael
01330 SUBNITTAL FAOCEDURES
03514 SAFETY, HEALTH, AND EMERGERCY RESFOMSE HTRwWAUST]
420 SOUACES FOR REFERENCE PUBLICATIONS _ we |
[ pvsepicn (12 Al Diivition 02 Sectiona
0237 eucareaTIRG. RACKFILLING, AMD COMPACTING FOR STRUCTURES
232 eecavaTIDN, BACEFILLING, AND COMPALCTIMG FOR UTILITES
F3H EMBAREMENT
45D WD PRES
02473 DRILLED CONCRETE PIERS
02515 WATER SYSTEMS
OESES MEDILM VIILTAGE UNDERGROUND FOWER DISTRIBUTION
D reiacan 03 A0 Direviacn 00 Secbors
OFEXS MEULATIMG COMCRE TE BECKS :I
Frrde
Hame:  |HF Latsulet 4100 F5 =l _Isﬂ"

the right pane. The Reports will have a file extension .RPT and a red
icon. Double-click to open a Report in the Sl Editor.

u Three helpful hints that apply to resolving problems on any of the Reports:

3

1 Always check first to see if the problem is the result of a typographical error.
2 Display the Marks to check spacing — each space will be represented by one dot on the
screen. Show Marks using the command on the Editor’'s View menu.
Double-click any Section number within a Report to open that Section in the Editor.

Your cursor will be placed at the Subpart containing the problem. Tags are automatically
hidden when you use this hyperlinking from the Reports, but before making any changes,
display the tags on your screen to insure accuracy.
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Fixing QA [Report Errors and Discrepancies

Address Verification Report

The Address Verification Report
(ADDRVER.RPT) lists Reference Organizations
that appear in any Section’s Reference Article
without a corresponding listing in either the
01420 Section or the Supplemental Reference
List (SRL).

Remember: If you
don’'t have the 01420
Sources for Reference

Publications Section

as part of your Job you
Address Verification : can’t use this report.
e Verifies that all Sponsoring Organizations with References cited
in the processed Sections' text appear in the Job's 01420 Section.
e Generates a list of Sponsoring Organizations used in any Section’s Refer-
ence Article but not found in the Job's 01420 Section.

Example of Address Verification Results:

SECTION REFERENCE ORGANIZATION

16208 DIESEL ENGINE MANUFACTURERS ASSOCIATION (DEMA)

If the 01420 Section of the Job doesn't list the

Reference’s Sponsoring Organization:

Resolving Discrepancies ; cat
1 Addthe Sponsoring Organization name,

acronym, Reference Identifier and Refer-
ence Title (with all corresponding tags) to
the Section’s Reference Article.

2 Right-click on the Reference Identifier you
just added, and choose Check References
from the pop-up menu.

3 Click Yes when prompted to automatically
add the Reference to your Supplemental
Reference List (which will open so that you
can confirm the addition).

4 Open your Job’s 01420 Section and add the
Sponsoring Organization name, acronym,
address, phone/fax numbers, email ad-
dress and web address (with all corre-
sponding tags) making certain that text,
spaces and capitalization are identical to the
listing you added to the Reference Article.

Chaptar & S

If the 01420 Section of the Job already
lists the Reference’s Sponsoring Orga-
nization:

1 Addthe Sponsoring Organization
name, acronym, Reference lden-
tifier and Reference Title (with all
corresponding tags) to the Sec-
tion’s Reference Article.

2 Verify that the information that you
added to the Section’s Reference
Article is identical — including text,
spaces, and capitalization — to the
one found in the 01420 Section.




Fixing QA [Report Errors and Discrepancies

Reference Verification Report

The Reference Verification Report actually produces three separate listings: Duplicate
References (DUPEREF.RPT), Reference Title Discrepancies (TTLFIFFS.RPT), and
References Verification (REFVER.RPT).

Reference Verification:

e Compares the References in each Section’s text with those in its Reference
Article and in the Supplemental Reference List (SRL).

¢ |dentifies discrepancies by producing three separate reports that list duplicate
References, conflicting Titles, and unresolved References.

Duplicate References

The DUPEREE.RPT Example of Duplicate Reference Results:

lists of all the Refer- SECTION REFERENCE
ences that are found in
the Reference Articles
and duplicated in the AMERICAN NATIONAL STANDARDS INSTITUTE (ANSI)
Supplemental Refer-
ence List. The Refer-
ence Descriptions
listed on the report are |02200 ASTM C29
from the Supplemental
Reference List.

16208 ANSI Bl6.11

ANSTI B16.11 1980 Forged Steel Fittings, Socket-Welding and
Threaded

ASTM C29 1978 Unit Weight and Foids Aggregate

&M Resolving Duplicate References

Check References in the Sections' Reference Articles against those in the Supplemental

Reference List (SRL).

¢ |If the duplicates are identical in both locations (exactly the same text, spacing and capital-
ization) then remove the duplicate from the SRL.

If the duplicates have differences in the titles or dates, your engineer should review the publi-

cations to determine which is applicable to the Section:

e If the SRL contains the correct Reference, edit the Section’s Reference Article to correct
it, then remove the duplicate from the SRL.

e |f the Section’s Reference Article contains the correct Reference, remove the duplicate
from the SRL.

After all corrections are made, run Reference Reconciliation again.
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Fixing QA [Report Errors and Discrepancies

Reference Verification Report

Reference Title Discrepancies

The TTLDIEES.RPT lists Example of Reference Title Discrepancies

Reference ldenti-
fiers with conflicting
Reference Titles in
two or more Section
Reference Articles.

e Compare Titles and determine which is correct for the publication. If pub-
lication dates differ, the engineer should review the publication to deter-
mine which applies to the Section.

e Edit the listed Sections’ Reference Articles so that they all reflect the
correct Title and date for the publication.

SECTION REFERENCE Reference Title

03300 NEMA TC 2 (1983) Electrical Plastic Tubing (EPT) and Conduit

03302 NEMA TC 2 (1983) Electrical Plastic Tubing (EPT) and Conduit
(EPC-40 and EPC-80)

Resolving Reference Title Discrepancies

Unresolved References

The REFVER.RPT lists References that Example of Unresolved References Results:
appear in any Section’s text but not in

either the Section’s Reference Article
or the Supplemental Reference List.

SECTION SUBPART REFERENCE

02515 2.1.1 AWWA C110

Correcting Unresolved References

e Add the Reference and Reference Title (which includes
the Publication date) to either the Section’s Reference Arti-
cle or Supplemental Reference (SRL).

e |f you made your changes in the SRL, then run Reference
Reconciliation again to automatically insert them in the
Reference Articles.
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Fixing QA [Report Errors and Discrepancies

Submittal Verification [Report

The Submittal Verification Report (SUBMVER. RPT)
lists Sections that do not cite Submittal Items 3
in both the Submittal Article and elsewhere in
the text, that cite invalid Classifications, or that
contain Submittal Descriptions or Classifica-
tions outside the Submittal Article. It also re-
ports Submittal Descriptions from Sections’ Submittal Procedures
Submittal Articles that differ from those found Section as part of your
in the 01330 or that are missing from it. Job you can’t use this
report.

Remember: If you
don’t have the 01330

Submittal Verification:
e Checks that all Submittal ltems appear both in the Sections’
Submittal Article and also in the Sections’ text.

e Generates a list of Submittal Items missing from either location.
See Example A.

e Checks that all Submittal Descriptions used in the Sections’
Submittal Articles are also listed in the Job’s 01330 Section.

e Generates a list of Submittal Descriptions missing from the
01330 Section.
See Example B.

Example A of Submittal Verification Results:

SECTION SUBPART SUBMITTAL DISCREPANCY

05120 2.1 Classification “GA”
is invalid for the unified Submittal format.

05120 2.1 “GA”
was not found in the Submittal Article

05120 2.4 “SHOP PRIMER”
was not found in the Submittal Article

05120 1.4 “Accessoriesg”
was not found outside the Submittal Article
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Fixing QA [Report Errors and Discrepancies

Submittal Verification [Report

Correcting Submittal Verification Discrepancies
Example A

e |f a Submittal Item appears under an SD number within the Submittal Article but
nowhere in the Section text, either add the Submittal ltem at the appropriate point in the
text, or delete it from the Submittal Article.

e |If a Submittal Item is located within the text but not in the Submittal Article consult your
engineer to determine which one of the following methods of correction is appropriate:
Insert it in the Submittal Article below the correct SD number.
Remove the <SUB> tag surrounding the Item within the text.
Delete both the Item and <SUB> tag from the text.

e Submittal Descriptions (SDs) and Classifications (G for Government Approved) can only
appear in the Submittal Article. Any citations of these in the text (outside the Submittal Ar-
ticle) must be deleted.

Example B of Submittal Verification Results:

STANDARD DESCRIPTION
SECTION SUBPART INVALID DESCRIPTION

SD-03 Product Data

03300A 1.4 SD-03 Product Materials

Correcting Submittal Verification Discrepancies
Example B

Submittal Description (SD) Numbers used in the Job must be listed in the Job’s
01330 Section.

e |f the SD Number reported is a valid Submittal that is not found in Section
01330, then add it to the 01330.

e |f the SD Number reported is invalid, it must be changed to one of the eleven
valid numbers cited in the 01330 Section, or omitted from the Section.
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Fixing QA [Report Errors and Discrepancies

Bracket Verification and Section Verification [Reports

The Bracket Verification Re-
port (BRKTVER.RPT) lists all
brackets remaining in the Sec-
tions that must be removed and
replaced with text before a Job
is complete.

Example of Bracket Verification Results:

SECTION SUBPART Brackets Found
01011 1.4.3 2
05210 1.3 3
05210 1.4 1
05210 2.2 4
05210 3.1 2

Resolving Bracket Verification Problems

o |If a bracket was inadvertently left in the text, delete the bracket.

e If Bracketed Options were left in the text, a selection must be
made or information filled in and the brackets deleted. Consult
your engineer to determine the correct option to include.

The Section Verification Re-
port (SECTVER.RPT) lists any
Sections that are referenced in
other Sections of the Job, but
that are not part of the Job.

Example of Section Verification Results:

Section Verification:

SECTION SUBPART Section Referenced
07270 3.3.3 15895
15330 1.4.7 01730

e Checks to see that all Sections cited in the text are included

in the Job.

e Generates a list of any Sections referenced that are not in-

cluded in the Job.

Resolving Section Verification Discrepancies

Check with your engineer to determine if you should:
e Add the referenced Sections to the Job.

¢ Remove the text that references the missing Section.
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[Report Lists

[Reference Location, Submittal and Test Lists

The Reference List (REFKYLST.RPT) includes all the References cited in the
Job, followed by the Sections and Subpart Numbers where they can be found.

10 CFR 430
SECTION: 15400 SUBPART: 1.1
SECTION: 15400 SUBPART: 3.10.1.1

16 cfr 1201

SECTION: 08810 SUBPART: 1.1

SECTION: 08810 SUBPART: 2.5.1

The Submittal List (SUBMLIST.RPT) includes all the Submittal Descriptions
found in the Submittal Articles, along with the Sections and Subparts in
which they can be found. The SD definitions are extracted from the 01330 Sec-

tlon SD-02

Submittals which graphically show relationship of various components
of the work, schematic diagrams of systems, del of fabrications, lay-

out of particular elements, connections, and other relational aspects
of the work.

SECTION: 09330 SUBPART: 1.2
SECTION: 09515 SUBPART: 1.2
SECTION: 09675 SUBPART: 1.2

The Test / Requirements List (TSTRQLST.RPT) includes all the Test Re-
guirements cited in the text, along with the Sections and Subparts in which

they can be found. [gecrron: 02220 SUBPART: 1.2

Do not begin demolition until authorization is received

from the Contracting Officer.
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The Submittal Register

The Submittal Register lists the materials, products or items for each Submittal cited in the
Job, as well as the Section and paragraph number locations, and any required approval.

When the Submittal Register is generated, the system:

e Searches for the Submit- =
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tal Article within PART 1 [=
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the SDs and throughout

the Sections.
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Register and inserts the

b e =

Subpart location for each

Submittal Iltem in the Sections’ text (outside the

Submittal Articles).

Troubleshooting the Submittal Register

Column (f) Classification Gov-
ernment or A/E Reviewer has
double G G

Column (e) Paragraph # is
blank

A/E appears in Column (d) in-
stead of Column (f).

The Submittal Item is listed
twice in the Submittal Article
under the same Submittal De-
scription.

The Submittal Item is only
found in the Submittal Article
and is not used anywhere in
the Section’s text.

Classification G must precede
Reviewer as follows:
<SUB>G A/E</SUB>

The Submittal Register
does not appear in the Sl
Explorer’s Processed
Files folder the way the
other reports and lists do. It
will, however, print when
you choose Process &
Print. If you are publishing
to PDF, it will appear in the
PDF Files folder in the Sl
Explorer, and you can view
it in that format.

FIO appears in Column (d) in-
stead of Column (f).

FIO is no longer recognized on
the UFGS Submittal Register
and should not be used in the
Submittal Article.
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[Restoring a Job From a Backup

Whether it's a Job in progress or a former Job, you may
want to take an archived backup you've created through
Specsintact and restore it. In addition, this is the same
function you’ll use when adding a downloaded Master to
your default Working Directory and the SI Explorer.

1 From the Sl Explorer, click the File menu and choose Backup/Re-
store/Manage

2 Click the Restore/Manage tab.

3 Inthe Restore From area of the dialog box, select the Drive, Folder
and File you want to restore.

4 The information about the backup chosen will be entered in the boxes
on the right side of the screen. You may change the Name in the field
(a name appearing in red indicates a project with that name already ex-
ists).

5 You can choose to:

0 Overwrite Existing files, which will completely remove the files
under this name in its original Working Directory and replace them
with the backup files

or

0 Merge with Existing files, which will both replace all files of the
same names with the backup versions, and will also add any addi-
tional files in the backup that do not already exist in the Working Di-
rectory version.

6 Click OK.

-_
You can only change the Working
Directory destination if you change the
Name of the project you are restoring.
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Job Checklist

+ Make sure you have the most recent Software and Masters, and, if
necessary, download newer versions from the Specsintact web site
(software and NASA Masters) or CCB web site (UFGS Masters).

+ Print the Master Table of Contents with Scope (which lists the Sec-
tion numbers, Titles, and a brief descriptions of each Section in the
Master).

+ Give this list to your engineer so that the Sections necessary for the
Job can be determined.

+ When the engineer returns the list, print the Sections requested. Be-
fore printing them, ask whether they should show English or Metric
Units of Measure, and make sure that you also show the Notes.

+ When you receive the marked-up Sections from the engineer, make
certain to ask whether you are required to show the edits using the
Revisions feature.

+ Create the Job and add the Sections requested. Remember that the
software will automatically add two Sections — 01330 and 01420 —
which are necessary for processing the Job.

+ Begin editing, and remember to always edit with Tags visible on the
screen. You can also toggle on and off the Marks, Notes, and Revi-
sions (if you're using Revisions). Save your Section often as you edit.
When you do, it will produce a Validation Log that will flag certain
mistakes (the Validation Log can be turned on or off from Tools | Op-
tions | Save screen).

¢ Use the Process & Print/Publish function to generate the Reports
and perform Reconciliation (processing the entire Job for accuracy),
and correct any errors or discrepancies found. Don’t forget to rerun
the reports after any changes and until all findings are resolved.

+ Run a Spell Check after all changes are made.

+ Visually check the formatting by toggling off all the screen elements.
Check spacing and lines. Generally, you should have one blank line
between paragraphs. Turn Tags and Marks back on before deleting
any blank lines.

+ Create the finished Job (selecting all the Reconciliation options)
choosing the output file type desired — SI print (.prn) files can be sent
directly to the printer, while PDF and Word files are only produced
electronically. These files can be printed to paper through the SI Ex-
plorer. Remember the Submittal Register is not visible in the SI Ex-
plorer (except in PDF), nor is an .rtf cover sheet, and they cannot be
produced if you are using Word for your output format.

i Spocsiniact Chaptar 6




Wrap up

NCOuUNtered

upport robLemsS

“I think I am prepared to use Specslintact, but | have a
few questions. Can | call tech support for assistance?”
— Shirley in Shreveport

Of course you can! The SI Tech Support staff will be happy to
answer your questions. It's better to ask before you make a
serious mistake than to wait until you've spent hours working
on a Job, only to find out you need hours more to correct it.
Don't forget to use the Help menu as you work, and to use
the Sl web site as a resource as well.

L

Chapter 6

What you learned from this chapter:

How to use tools, shortcuts and other techniques to edit more effi-
ciently.

There are specific rules regarding use of symbols and capitaliza-
tion with the text.

Using the results from the QA Reports help you locate problems in
the Sections and fix them.

Helpful information is provided when the various Lists are gen-
erated during processing.

An archived Job can be restored using the SI Explorer.

Using a Job checklist can help you make certain you’'ve com-
pleted all the necessary steps to finish your Job.

S| Tech Support is there when you need it.




| Dally hopes you have found
> ¢ her quided tour helpful. If

=% you have any comments or
feedback regarding this
guide, please feel free to
pass them along to Specslintact

Tech Support.
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